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MOTTO 

 

“Sejatinya hidup adalah tentang pengabdian” 

 

 

“ Menghargai dan menghormati orang lain adalah bentuk lain dari 

menghargai diri sendiri” 

 

“ Yakinlah ada sesuatu yang menantimu selepas banyak kesabaran 

yang kau jalani, hingga membuatmu terpana dan lupa betapa pedihnya 

rasa sakit” 

(Ali bin Abi Thalib) 
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INTERPRETASI STRUKTUR BAWAH PERMUKAAN  

DAN IDENTIFIKASI JALUR SESAR MAYOR GRINDULU                 

BERDASARKAN DATA ANOMALI MEDAN MAGNET 

 

 

Liddiyah Agustiyaningrum 

14306141047 

 

ABSTRAK 

 

 Penelitian ini dilakukan di kawasan jalur Sesar Mayor Grindulu yang 

mencakup Kecamatan Pacitan dan Kecamatan Arjosari Kabupaten Pacitan. Tujuan 

dari penelitian ini adalah mengetahui  pola persebaran anomali medan magnet di 

kawasan jalur Sesar Mayor Grindulu, mengetahui  struktur bawah permukaan di 

kawasan jalur Sesar Mayor Grindulu, dan mengidentifikasi jalur Sesar Mayor 

Grindulu berdasarkan pemodelan magnetik. 

 Pengambilan data dilakukan menggunakan Proton Precession Magnetometer 

(PPM) pada tanggal 24 – 26 Agustus 2017 dengan 37 titik pengukuran dan spasi antar 

titik pengamatan 500-1000 m. Pengolahan data dilakukan dengan koreksi IGRF, 

koreksi variasi harian, reduksi ke kutub dan kontinuasi ke atas. Pemodelan dilakukan 

berdasarkan nilai anomali medan magnet yang telah direduksi ke kutub dan kontinuasi 

ke atas dengan ketinggian 1000 m. 

Hasil analisa menunjukkan bahwa rentang nilai anomali medan magnet di 

kawasan penelitian adalah -700 nT hingga 400 nT. Hasil pemodelan 2D menunjukkan 

bahwa struktur bawah permukaan Sesar Mayor Grindulu diperkirakan memotong 

lapisan batu pasir, batu gamping, batu tuf, dan batu breksi di daerah penelitian. Hasil 

pemodelan 3D menunjukkan bahwa jalur Sesar Mayor Grindulu memiliki karakteristik 

sesar geser yang berada pada formasi batuan yang sama (Formasi Toma). 

 

 

Kata kunci : anomali medan magnet, struktur bawah permukaan, Sesar Mayor   

Grindulu. 
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INTERPRETATION OF SUBSURFACE STRUCTURE                                   

AND IDENTIFICATION OF GRINDULU FAULT LINE                              

BASED ON MAGNETIC FIELD ANOMALIES  

 

 

Liddiyah Agustiyaningrum 

14306141047 

 

ABSTRACT 

 

 This study was conducted in the Grindulu Fault line area located at Pacitan 

District and Arjosari District in Pacitan Regency. The aims of this study were to 

determine the distribution pattern of magnetic field anomalies in the Grindulu Fault 

line, to identify the subsurface structure in the Grindulu Fault line area, and to identify 

the Grindulu Fault line based on magnetic modeling. 

Data acquisition was carried out using Proton Precession Magnetometer (PPM) 

on August 24-26, 2017 with 37 measurement points and the space between each 

measurement point was 500 to 1000 m. Data processing was done using IGRF 

correction, diurnal correction, reduce to pole transformation, and upward continuation 

transformation. Modeling process was done based on magnetic field anomalies that 

have been transformed using reduce to the pole (RTP) transformation and upward 

continuation transformation at 1000 m. 

The results of data analysis showed that the range of magnetic field anomalies in 

the study area ranged from -700 nT to 400 nT. 2D modeling result showed that the 

subsurface structure of the Grindulu Fault is guessed to cut through the rock layers 

that consist of sandstone, limestone, tuff, and breccia in the study area. 3D modeling 

result showed that the Grindulu Fault is a strike-slip fault and that it is only cut 

through one rock formation (Arjosari Formation). 

 

 

Keywords : magnetic field anomalies, subsurface structure, Grindulu Fault. 
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BAB I 

PENDAHULUAN 

 

A. Latar Belakang 

 Indonesia merupakan daerah pertemuan 3 lempeng tektonik besar, yaitu 

Lempeng Indo-Australia di bagian selatan, Lempeng Eurasia di bagian utara, dan 

Lempeng Pasifik di bagian timur. Ketiga lempeng tersebut saling aktif bergerak satu 

sama lain sehingga mengakibatkan terbentuknya zona subduksi. Zona subduksi adalah 

daerah pertemuan dua lempeng dimana salah satu lempeng relatif berada di bawah 

lempeng lainnya dan terus memberikan desakan pada lempeng lainnya. Gambar 1 

menunjukkan peta tatanan tektonik Kepulauan Indonesia. 

         

          

          

 

 

 

 

 

     

       

 

 

      Gambar 1. Peta Tatanan Tektonik  Kepulauan Indonesia (Bock et al., 2003)           
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   Lempeng Indo-Australia bergerak relatif ke utara dan menyusup ke bawah                                                                                                               

Lempeng Eurasia karena Lempeng Indo-Australia merupakan lempeng samudra yang 

memiliki berat jenis lebih besar dibandingkan lempeng benua sehingga lempeng 

samudra akan menunjam di bawahnya. Adanya akumulasi energi hasil desakan akibat 

pertemuan dua lempeng yang melampaui batas elastisitasnya mengakibatkan muncul 

bidang patahan atau sesar. Sesar adalah pergeseran antara dua blok batuan  baik secara 

mendatar, ke atas maupun relatif  ke bawah blok lainnya. Pergeseran antar blok 

mengakibatkan adanya akumulasi energi, sehingga menimbulkan gempabumi. Hal ini 

menunjukkan bahwa kawasan sesar atau patahan merupakan zona yang rawan terhadap 

gempabumi. 

 Pulau Jawa bagian selatan merupakan daerah yang rawan terjadi gempabumi 

karena terdapat banyak patahan atau sesar yang aktif. Beberapa di antaranya adalah 

Sesar Cimandiri, Sesar Opak, dan Sesar Grindulu. Sesar Cimandiri terletak di Jawa 

Barat, Sesar Opak di Yogyakarta, sedangkan Sesar Grindulu di Jawa Timur. Penelitian 

di kawasan Sesar Grindulu relatif masih minim dibandingkan dengan penelitian di 

kawasan Sesar Opak dan Sesar Cimandiri.  

 Penelitian mengenai Sesar Cimandiri yang pernah dilakukan yaitu penentuan 

karakteristik Sesar Cimandiri segmen Pelabuhan Ratu-Citarik dengan metode magnet 

bumi (Syirojudin, 2010) dan Sesar Cimandiri bagian timur dan implikasinya terhadap 

longsoran di Citatah Padalarang, Jawa Barat (Zakaria, 2009) . Penelitian mengenai 

Sesar Opak antara lain kajian pendahuluan Sesar Opak dengan metode gravitasi 

(Nurwidyanto, 2011) dan identifikasi jalur Sesar Opak berdasarkan analisis data 
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anomali medan magnet dan geologi regional Yogyakarta (Fathonah, 2011). Penelitian 

mengenai Sesar Grindulu yang telah dilakukan yaitu identifikasi Sesar Minor Grindulu 

berdasarkan data anomali medan magnet (Nurrohman, 2015) dan pemodelan anomali 

gravitasi dan identifikasi sesar lokal dalam penentuan jenis sesar di Pacitan (Parera, 

2015), dimana kedua penelitian tersebut masih terbatas pada sesar minor atau sesar 

lokal yang diteliti. 

   

 

 

 

 

 

 

 

 

            Gambar 2. Peta Kelurusan Struktur Sesar Grindulu (Hidayat et al., 2012)                              

 

   Kabupaten Pacitan terletak di Pulau Jawa bagian selatan yang berpotensi 

terhadap gempabumi akibat aktivitas lempeng tektonik Indo-Australia dan Eurasia. 

Catatan sejarah menunjukkan bahwa gempabumi di Kabupaten Pacitan yang terjadi 

pada tahun 1859 berkekuatan 7 SR, tahun 2013 berkekuatan 5,5 SR dengan kedalaman 

10 km, dan gempabumi pada tanggal 14 Juli 2014 berkekuatan 5,6 SR dengan 
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kedalaman 10 km. Berdasarkan goncangan gempa tersebut, Kabupaten Pacitan 

berskala IV MMI (Modified Mercali Intensity) (BMKG, 2014).  

  Sesar Grindulu pada Gambar 2 merupakan jalur patahan yang searah dengan 

jalur Sungai Grindulu. Sesar ini merupakan sesar mayor di Kabupaten Pacitan yang 

memiliki potensi untuk aktif di masa yang akan datang, sehingga diperlukan langkah-

langkah mitigasi untuk mengantisipasi kemungkinan terjadinya gempabumi akibat 

aktivitas Sesar Mayor Grindulu. Salah satu langkah mitigasi yaitu dengan mengetahui 

karakteristik Sesar Mayor Grindulu. Oleh karena itu, peneliti ingin mengkaji Sesar 

Mayor Grindulu menggunakan metode geomagnet.   

  Melihat kondisi geografis Pacitan yang berbukit-bukit, maka metode 

geomagnet adalah metode yang paling relevan untuk diterapkan. Peneliti memfokuskan 

pada metode geomagnet dengan memanfaatkan nilai suseptibilitas atau sifat 

kemagnetan batuan dengan melihat pola anomali medan magnet di daerah penelitian. 

Hasilnya diharapkan dapat menggambarkan  struktur bawah permukaan di jalur Sesar 

Mayor Grindulu.  Penelitian yang telah dilakukan dengan menggunakan metode 

geomagnet untuk mengidentifikasi jalur sesar di antaranya adalah identifikasi jalur 

Sesar Minor Grindulu berdasarkan data anomali medan magnet (Nurrohman, 2015), 

dan interpretasi struktur bawah permukaan dengan metode geomagnet di jalur Sesar 

Oyo (Heningtyas, 2017). Oleh karena itu, metode ini diharapkan mampu untuk 

menginterpretasi struktur bawah permukaan di kawasan jalur Sesar Mayor Grindulu 

sehingga peneliti melakukan penelitian dengan judul “Interpretasi Struktur  Bawah 
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Permukaan dan Identifikasi Jalur Sesar Mayor Grindulu Berdasarkan Data 

Anomali Medan Magnet”. 

 

B. Identifikasi Masalah 

 Berdasarkan latar belakang yang telah disampaikan, maka dapat diidentifikasi 

masalah-masalah sebagai berikut : 

1. Indonesia merupakan daerah pertemuan 3 lempeng, sehingga terdapat zona subduksi 

yang rawan akan bencana. 

2. Aktivitas sesar mampu menimbulkan gempabumi. 

3. Kabupaten Pacitan merupakan daerah yang dilalui oleh jalur Sesar Mayor Grindulu. 

4. Penelitian mengenai identifikasi pada jalur Sesar Mayor Grindulu belum pernah 

dilakukan menggunakan metode geomagnet. 

 

C. Batasan Masalah 

 Berdasarkan identifikasi masalah yang telah disampaikan, penelitian ini dibatasi 

pada : 

1. Kawasan penelitian yang mencakup Jalur Sesar Mayor Grindulu meliputi 2 

kecamatan, yaitu Kecamatan Pacitan dan Kecamatan Arjosari dengan koordinat  

8 ̊1’75,02’’ LS sampai 8 ̊ 1’28,33’’ LS  dan 111 ̊ 0’57,63’’ BT sampai 111 ̊ 1’24,65’’ 

BT. 

2. Akuisisi medan magnet menggunakan metode looping. 
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3. Nilai suseptibilitas batuan pada penelitian ini menggunakan satuan Standar 

Internasional (SI). 

 

D.  Rumusan Masalah 

 Berdasarkan batasan masalah di atas dapat diperoleh beberapa rumusan masalah 

sebagai berikut : 

1. Bagaimana pola persebaran nilai anomali medan magnet di kawasan Jalur Sesar 

Mayor Grindulu ? 

2. Bagaimana pemodelan struktur bawah permukaan di kawasan Jalur Sesar Mayor 

Grindulu berdasarkan persebaran nilai anomali medan magnet? 

3. Bagaimana identifikasi Jalur Sesar Mayor Grindulu berdasarkan persebaran nilai 

anomali medan magnet ? 

 

E. Tujuan Penelitian 

Berdasarkan rumusan masalah yang telah disebutkan, maka tujuan dari penelitian 

ini sebagai berikut : 

1. Mengetahui pola persebaran nilai anomali medan magnet di kawasan Jalur Sesar 

Mayor Grindulu. 

2. Mengetahui struktur bawah permukaan di kawasan Jalur Sesar Mayor Grindulu 

berdasarkan persebaran nilai anomali medan magnet. 

3. Mengidentifikasi Jalur Sesar Mayor Grindulu berdasarkan persebaran nilai anomali 

medan magnet. 
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F. Manfaat Penelitian                                                                                        

Manfaat dari penelitian ini adalah : 

1. Menambah informasi mengenai struktur bawah permukaan di kawasan jalur Sesar  

 Mayor Grindulu. 

2. Menjadi pertimbangan pemerintah dalam kegiatan pembangunan dan mitigasi. 
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BAB II 

TINJAUAN PUSTAKA 

 

A. Teori Kemagnetan 

1. Suseptibilitas Magnet 

   Kemampuan suatu material untuk termagnetisasi digambarkan oleh nilai 

suseptibilitas magnet (k). Suseptibilitas magnet (k) merupakan parameter fisis dari 

batuan yang dicari pada pengukuran geomagnet. Faktor yang mempengaruhi nilai 

suseptibilitas adalah litologi dan mineral-mineral penyusun batuan. Nilai suseptibilitas 

batuan ditunjukkan pada Tabel 1-4. 

 Jika sebuah material dengan nilai suseptibilitas magnet (k) diletakkan pada medan 

magnet luar dengan kuat medan magnet H (A/m), maka material tersebut akan 

terinduksi oleh medan magnet luar sehingga memiliki nilai intensitas magnetisasi M 

(A/m) yang ditunjukkan oleh (Telford et al., 2004): 

                                                          M = k H               (1) 

     Tabel 1. Nilai Suseptibilitas Batuan Metamorf (Telford et al., 2004) 

 

 

 

 

Nama Batuan Kisaran (×10-3) Rata-rata (×10-3) 

Amphibolite  0,7 

Schist 0,3-3 1,4 

Phyllite  1,5 

Gneiss 0,1-25  

Quartzite  4 

Serpentine 3-17  

Slate 0-35 6 
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                       Tabel 2. Nilai Suseptibilitas Batuan Beku (Telford et al., 2004) 

 

                   

 

 

 

 

 

 

      Tabel 3. Nilai Suseptibilitas Mineral Batuan (Telford et al., 2004) 

 

 

 

 

 

 

 

 

 

Nama Batuan Kisaran (×10-3) Rata-rata (×10-3) 

Granite 0-50 2,5 

Rhyolite 0,2-35  

Dolorite 1-35 17 

Augite-syenite 30-40  

Olivine-diabase  25 

Diabase 1-160 55 

Porphyry 0,3-200 60 

Gabbro 1-90 70 

Basalts 0,2-175 70 

Diorite 0,6-120 85 

Pyroxenite  125 

Peridotite 90-200 150 

Andesite  160 

Mineral Kisaran (×10-3) Rata-rata (×10-3) 

Graphite  0,1 

Quartz  -0,01 

Rock salt  -0,01 

Anhydrite, gypsum  -0,01 

Calcite -0,001- -0,01  

Coal  0,02 

Clays  0,2 

Chalcopyrite  0,4 

Sphalerite  0,7 

Cassiterite  0,9 

Siderite 1-4  

Pyrite 0,05-5 1,5 

Limonite  2,5 

Arsenopyrite  3 

Hematite 0,5-35 6,5 

Chromite 3-110 7 

Franklinite  430 

Pyrrhotite 1-6000 1500 

Ilmenite 300-3500 1800 

Magnetite 1200-19200 6000 
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                   Tabel 4. Nilai Suseptibilitas Batuan Sedimen (Telford et al., 2004) 

 

 

2. Induksi Magnet 

Adanya medan magnet yang berasal dari bumi menyebabkan terjadinya induksi 

magnet. Induksi magnet B adalah medan magnet total yang masih dipengaruhi oleh 

medan magnet bumi B0 dan medan magnet hasil induksi Bm dari material yang 

memiliki nilai suseptibilitas. Secara umum ditunjukkan pada persamaan 2 (Serway & 

Jeweet, 2004): 

    B = B0 + Bm                                                                                         (2) 

dengan B0 didefinisikan sebagai: 

                                                 B0  = 𝜇0H                                                               (3) 

dengan  𝜇0 adalah permeabilitas ruang hampa dengan nilai 4𝜋 × 10−7 Wb A m⁄ , 

sedangkan Bm didefinisikan sebagai: 

Bm = 𝜇0M                                                                   (4)  

Persamaan 3 dan 4 disubstitusikan ke persamaan 2 sehingga diperoleh: 

     B = 𝜇0 (H + M)                                                       (5) 

    Nama Batuan Kisaran (×10-3) Rata-rata (×10-3) 

Dolomite 0 - 0,9 0,1 

Limestone 0-3 0,3 

Sandstone 0-20 0,4 

Shales 0,01-15 0,6 
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Substitusi persamaan 1 dan 5 ke persamaan 6, sehingga didapatkan persamaan 

induksi magnet B sebagai berikut (Telford et al., 2004) 

    B = 𝜇0 (H + M) =  𝜇0 (1 + k )H =  𝜇0𝜇r H                      (6)     

dengan 𝜇r = (1+k) adalah permeabilitas relatif. 

B. Medan Magnet Bumi 

Medan magnet bumi memiliki komponen atau elemen-elemen dengan tiga arah 

utama yang dinyatakan dalam koordinat kartesian (Gambar 3) dengan 𝑋𝑒 komponen 

arah utara, 𝑌𝑒 komponen arah timur, dan 𝑍𝑒 komponen arah vertikal (Telford et al., 

2004). 

 

 

 

 

 

                    

 

 

 

 Gambar 3. Elemen-Elemen Medan Magnet Bumi (Telford et al., 2004) 
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Elemen-elemen medan magnet bumi terdiri atas: 

1. Deklinasi (D),  yaitu sudut antara utara magnet bumi dengan komponen horizontal 

yang dihitung dari arah utara menuju timur (sudut antara utara magnet bumi dan 

utara geografis). 

2. Inklinasi (I), yaitu sudut antara medan magnet total dengan bidang horizontal yang 

dihitung dari bidang horizontal menuju bidang vertikal ke bawah (sudut antara 

bidang horizontal dan vektor medan magnet total). 

3. Komponen horizontal (𝐻𝑒), yaitu magnitudo dari medan magnet total pada arah  

horizontal. 

4. Medan magnet total (𝐹𝑒), yaitu magnitudo dari vektor medan magnet total. 

Berdasarkan analisis harmonik sferis dari medan magnet terukur di permukaan 

bumi, hampir 99% dari medan magnet yang terukur berasal dari dalam bumi yang 

disebut medan magnet utama bumi (Telford et al., 2004). Medan magnet utama bumi 

berubah terhadap waktu relatif lebih lambat yang disebut variasi sekuler. Untuk 

menyeragamkan nilai medan magnet utama bumi dibuat standar nilai yang disebut 

International Geomagnetics Reference Field (IGRF) yang diperbaharui setiap 5 tahun 

sekali. Nilai IGRF dapat diperoleh dari website NOAA. 

Nilai total intensitas medan utama berkisar 25.000 nT - 65.000 nT dan untuk 

Pulau Jawa nilai medan utamanya berkisar ±45.000nT (Gambar 4). Nilai deklinasi dan 

inklinasi berkisar -90o sampai 90o dan untuk Pulau Jawa nilai deklinasinya berkisar 0o 
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- 2o dan inklinasinya berkisar -20o sampai 40o ditunjukkan oleh Gambar 5 dan Gambar 

6. 

 

        

 

 

 

 

 

            

                    

                 Gambar 4. Model Medan Magnet Bumi (NOAA, 2015) 

 

 

 

 

 

 

 

 

 

 

 

 

       

     Gambar 5. Model Inklinasi Medan Magnet Bumi (NOAA, 2015) 
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   Gambar 6. Model Deklinasi Medan Magnet Bumi (NOAA, 2015) 

 

C. Medan Magnet Luar 

Medan magnet luar adalah medan magnet yang berasal dari pengaruh luar bumi. 

Medan magnet luar ini menyumbang porsi yang kecil dalam pengukuran medan magnet 

total. Medan magnet luar ini disebabkan oleh adanya arus listrik di ionosfer yang 

bervariasi sangat cepat terhadap waktu (Telford et al., 2004). Beberapa hal yang 

mempengaruhi medan magnet luar antara lain: 

1. Siklus 11 tahun sekali yang berhubungan dengan bintik matahari. 

2. Variasi harian matahari dengan periode 24 jam yang berkisar hingga 30 nT dan 

bervariasi terhadap ketinggian lintang maupun musim serta dipengaruhi oleh adanya 

angin matahari dan arus di ionosfer. 
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3. Variasi harian dengan periode 25 jam yang berhubungan dengan pasang surut bulan 

dan mempunyai jangkauan 2 nT. 

4. Badai magnetik yaitu gangguan yang bersifat sementara dengan jangkauan hingga 

lebih dari 1.000 nT.  

Medan magnet luar ini juga harus direduksi sehingga perlu dilakukan koreksi 

variasi harian. Untuk mendapatkan nilai variasi harian, digunakan persamaan 

(Gravmag, 2015): 

                                               𝐵𝑉𝐻=
𝑡𝑛-𝑡𝑎

𝑡𝑏-𝑡𝑎
(𝐵𝑏-𝐵𝑎)                                            (7)      

dengan 𝑡𝑛 adalah waktu saat pengukuran dalam detik, 𝑡𝑎 adalah waktu pengukuran di 

base awal dalam detik, 𝑡𝑏 adalah waktu pengukuran di base akhir dalam detik, 𝐵𝑏 

adalah nilai medan magnet total yang terukur di base akhir dalam nT, dan 𝐵𝑎 adalah 

nilai medan magnet total di base awal dalam nT. 

D. Anomali Medan Magnet 

Anomali medan magnet merupakan nilai hasil perhitungan medan magnet 

setelah dikoreksi IGRF dan variasi harian. Adanya anomali medan magnet disebabkan 

oleh variasi susunan mineral-mineral magnetik yang terkandung dalam batuan. Karena 

arah B sama dengan 𝐵𝐼𝐺𝑅𝐹 dan 𝐵𝑉𝐻 maka nilai anomali medan magnet ∆𝐵 ditunjukkan 

pada persamaan 8  (Telford et al., 2004): 

                                                         ∆𝐵 = 𝐵 − 𝐵𝐼𝐺𝑅𝐹 ± 𝐵𝑉𝐻                         (8) 
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dengan  B adalah nilai medan magnet total dalam nT, 𝐵𝐼𝐺𝑅𝐹  adalah nilai IGRF yang 

mewakili medan magnet utama bumi B0 dalam nT, 𝐵𝑉𝐻 adalah nilai variasi harian 

dalam nT. 

E. Kemagnetan Material Bumi 

Setiap jenis material mempunyai sifat dan karakteristik tertentu dalam medan 

magnet. Material diklasifikasikan menjadi empat jenis berdasarkan nilai suseptibilitas 

magnet, yaitu diamagnet, paramagnet, ferromagnet, dan ferrimagnet (Hinze et al., 

2012). 

1. Diamagnet 

Diamagnet adalah material yang kulit elektronnya lengkap dan terisi oleh 

elektron yang berpasangan. Jika dipengaruhi oleh medan magnet luar, spin elektron 

akan menghasilkan arah momen magnet yang berlawanan dengan arah medan magnet 

luar sehingga akan menghasilkan resultan yang berarah negatif. Diamagnet memiliki 

nilai suseptibilitas k< 0 atau negatif. 

2. Paramagnet         

  Paramagnet adalah material yang memiliki jumlah elektron tidak lengkap 

(sebagian ada elektron yang tidak berpasangan) pada kulit atomnya. Tanpa pengaruh 

kuat medan magnet luar, momen magnet memiliki arah orientasi yang acak, sehingga 

apabila ada pengaruh dari medan magnet luar, maka momen magnet akan sejajar 
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dengan medan tersebut. Paramagnet memiliki nilai suseptibilitas yang positif namun 

sangat kecil berkisar antara 0 <k< 10-3 dalam satuan SI.  

3. Ferromagnet 

Ferromagnet adalah material yang sifat kemagnetannya dipengaruhi oleh 

temperatur, yaitu pada temperatur di atas temperatur Curie akan kehilangan sifat 

kemagnetannya. Jika dimasukkan ke dalam medan magnet luar, magnetisasi bahan ini 

akan meningkat secara signifikan. Material yang bersifat ferromagnet memiliki nilai 

suseptibilitas yang selalu positif dan lebih besar dari k >1. 

4. Ferrimagnet 

Ferrimagnet adalah material yang sifat kemagnetannya seperti ferromagnet 

yaitu dipengaruhi oleh temperatur. Tanpa adanya pengaruh kuat medan magnet luar, 

arah momen magnetnya parallel dan saling berlawanan. Ferrimagnet memiliki nilai 

suseptibilitas 10-3< k < 0 SI.  

F. Transformasi 

1. Reduksi ke kutub 

Proses transformasi reduksi ke kutub atau Reduction to pole (RTP) merupakan 

tahapan untuk memposisikan benda penyebab anomali secara tepat berada pada arah 

vertikal dengan mengubah arah magnetisasinya. Proses ini dilakukan dengan 

mengubah nilai deklinasi 0,91° dan inklinasi -33° pada daerah penelitian menjadi 
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berada di daerah kutub yang memiliki nilai deklinasi 0° dan inklinasi 90°. Hal tersebut 

menjadikan medan magnet yang awalnya bersifat dipole menjadi monopole. 

 

2. Kontinuasi ke atas 

Kontinuasi ke atas dilakukan dengan mentransformasi medan potensial yang 

diukur di permukaan tertentu ke medan potensial pada permukaan lainnya yang lebih 

jauh dari sumber. Persamaan 9  menjelaskan prinsip dasar dari proses kontinuasi ke 

atas, yaitu suatu medan potensial dapat dihitung pada setiap titik di dalam suatu daerah 

berdasarkan sifat medan pada permukaan yang melingkupi daerah tersebut. Proses ini 

dilakukan untuk mereduksi anomali yang berasal dari sumber yang dangkal dengan 

melihat kecenderungan pola kontur hasil kontinuasi ke atas pada ketinggian tertentu. 

 

 

 

 

         

 

 

 

 

 

            Gambar  7. Kontinuasi ke Atas pada Permukaan Horizontal (Blakely, 1996) 

 

 

Konsep dasar transformasi ini berasal dari identitas ketiga Teorema Green. 

Teorema ini menjelaskan bahwa apabila suatu fungsi U bersifat harmonik, kontinu dan 
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mempunyai turunan yang kontinu di sepanjang daerah R maka nilai U pada suatu titik 

P di dalam daerah R (Gambar 7) dapat dinyatakan dalam persamaan (Blakely, 1996): 

                             𝑈(𝑃) =
1

4𝜋
∫ (

1

𝑟

𝜕𝑈

𝜕𝑛
− 𝑈

𝜕

𝜕𝑛

1

𝑟
)

𝑆
𝑑𝑆                (9) 

dengan S menunjukkan permukaan daerah R, n menunjukkan arah normal keluar, dan 

r adalah jarak dari titik P ke suatu titik di permukaan S.  

 

G.  Proton Precession Magnetometer                                                                                         

  Proton Precession Magnetometer atau PPM merupakan alat untuk mengukur 

medan magnet total atau B. Alat ini terdiri dari tabung sensor dan tabung console.  

Tabung sensor berisi koil atau kumparan yang melingkupi zat cair yang kaya akan 

proton (kerosin atau minyak tanah), sedangkan pada tabung console terdapat baterai, 

amplifier, dan rangkaian penghitung frekuensi atau counter.  

Prinsip kerja PPM didasarkan pada putaran dari partikel bermuatan. Putaran 

dari partikel bermuatan ini menghasilkan momen magnet dan momentum angular pada 

arah sumbu putarnya. Setiap proton adalah massa yang berputar dan membawa muatan 

listrik positif, sehingga  sumbu proton akan berpresesi, seperti ditunjukkan pada 

Gambar 8. Jumlah putaran sumbu proton di sekitar sumbu dalam waktu tertentu disebut 

frekuensi presesi proton (𝑓). Nilai 𝑓 tergantung pada momen magnet proton 𝑚, 

momentum angular proton 𝐿, dan medan magnet bumi 𝐵 yang dapat dinyatakan dalam 

persamaan (Telford et al., 2004): 

𝑓 =
𝑚

2𝜋𝐿
𝐵 =

𝐺𝐵

2𝜋
                   (10) 
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dengan konstanta 𝐺 =
𝑚

𝐿
 adalah rasio giromagnet dan faktor dari 

2𝜋

𝐺
= 23,487 ±

0,002 nT/Hz, maka persamaannya dapat dituliskan sebagai: 

𝐵 = 23,48𝑓 (nT)              (11) 

 

 

 

 

 

 

 

 

 

 

 Gambar 8. Analogi Proton Precession dan Spinning-Top (Telford et al., 2004) 

 

Pada saat pengukuran, tabung sensor dihubungkan dengan kabel penghubung 

ke tabung console dan tongkat penyangga sensor. Ketika antara tabung sensor dan 

tabung console belum dihubungkan maka tidak ada arus yang melalui kumparan 

sehingga tidak ada medan magnet di sekitar kumparan yang mengakibatkan proton-

proton di dalam sensor mempolarisasikan diri ke arah medan magnet bumi. Namun, 

ketika tabung sensor dan tabung console sudah dihubungkan maka terdapat arus yang 

melewati kumparan sehingga menimbulkan medan magnet baru di sekitar kumparan. 

Hal ini mengakibatkan proton-proton tersebut mempolarisasikan diri pada medan 

magnet  kumparannya. Pada saat menekan tombol READ pada tabung console yang 

artinya memutus arus, pada saat tersebut kumparan akan dihubungkan dengan 
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rangkaian penghitung frekuensi, sementara proton akan berpresesi pada arah medan 

magnet bumi. Gerakan momen magnet proton akan menghasilkan medan magnet siklik 

yang menginduksi arus pada kumparan dengan interval ~3 detik sebelum proton 

berhenti berpresesi. Selama interval waktu tersebut, penghitung frekuensi akan 

mengukur frekuensi presesi proton. Nilai frekuensi presesi proton yang terukur 

kemudian diolah dan nilai medan magnet total ditampilkan pada layar PPM (Telford et 

al., 2004). 

H. Sesar 

Sesar atau patahan merupakan struktur retakan yang mengalami pergeseran 

(Noor, 2012). Sesar terjadi karena batuan mengalami efek tegangan yang melampaui 

kekuatan elastisitasnya. Pergeseran blok batuan yang retak tersebut dapat terjadi 

dalam jarak yang sangat kecil sampai dengan skala yang lebih besar atau disebut 

dengan daerah sesar skala regional. 

 Dalam keadaan yang sebenarnya, permukaan sesar dapat mempunyai keadaan 

yang berbeda dan gerakannya dapat mempunyai arah yang berlainan sepanjang 

permukaannya. Gerakan sesar dapat diklasifikasikan menjadi tiga, antara lain: 

a. Normal Faults  

 Normal faults atau sesar turun adalah patahan yang terjadi karena gaya tegasan 

tensional horizontal pada batuan yang bersifat retas dimana hanging block telah 
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mengalami pergeseran relatif ke arah bagian bawah terhadap  footwall block yang 

ditunjukkan pada Gambar 9. 

 

 

 

 

  Gambar 9. Normal Faults atau Sesar Turun (Noor, 2012) 

 

b.  Reverse Faults 

 

 

 

 

 

 

Gambar 10. Reverse Faults atau Sesar Naik (Noor, 2012) 

 

Reverse faults atau sesar naik adalah patahan yang terjadi karena gaya tegasan 

kompresional horizontal pada batuan yang bersifat retas, dimana hanging block 

berpindah relatif  ke arah atas terhadap footwall block yang ditunjukkan pada Gambar 

10.  
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c. Strike Slip Faults  

 Strike slip faults atau sesar geser adalah patahan yang pergerakan relatifnya 

berarah horizontal mengikuti arah pergerakannya. Patahan jenis strike slip faults dapat 

dibagi menjadi dua tergantung pada sifat pergerakannya. Dengan mengamati pada 

salah satu sisi bidang patahan yang berlawanan maka jika bidang pada salah satu sisi 

bergerak ke arah kiri disebut patahan left-lateral strike slip faults. Jika bidang patahan 

pada sisi lainnya bergerak ke arah kanan disebut right-lateral strike slip faults yang 

ditunjukkan pada Gambar 11. 

 

 

 

                              

   (a)                                                      (b) 

Gambar 11. Sesar Geser (a) Left-lateral strike slip faults (b) Right-lateral strike slip 

faults 

 

I. Pembagian Umur Geologi 

  Untuk mempermudah menganalisa gejala geologi dan memperkirakan umur   

batuan, para ahli geologi membagi waktu geologi menjadi satuan-satuan yang lebih 
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kecil serta memberi nama pada tiap-tiap satuan tersebut dalam skala waktu geologi 

yang ditunjukkan pada Tabel 5. 

                       Tabel 5. Jangka Skala Waktu Geologi (Noor, 2012) 

Zaman Kala 
Jangka Waktu 

( 106 tahun yang lalu) 

Kwarter 

  

Holosen 

Pleistosen 

Sekarang 

? 

- 

- 

? 

0,6 

Tersier Pliosen 

Miosen 

Oligosen 

Eosen 

Paleosen 

0,6 

11 

25 

40 

60 

- 

- 

- 

- 

- 

11 

25 

40 

60 

70 

Kapur 

Jura 

Trias 

 70 

135 

180 

- 

- 

- 

135 

180 

225 

Perm 

Pensylvanian 

Mississipian 

Devon  

Silur  

Ordovisium 

Kambrium 

 225 

270 

330 

350 

400 

440 

500 

- 

- 

- 

- 

- 

- 

- 

270 

330 

350 

400 

440 

500 

600 

Pra Kambrium  600 - 4500 

 

J. Geologi Daerah Penelitian 

 Secara fisiografi daerah Pacitan dan sekitarnya terletak pada jalur Pegunungan 

Selatan Jawa Timur yang termasuk dalam Formasi Andesit Tua. Pegunungan Selatan 

bagian timur memanjang dari Yogyakarta hingga Semenanjung Blambangan yang 

ditunjukkan pada Gambar 12 (Bemmelen, 1949). 

  Pada daerah Pacitan dan sekitarnya berkembang struktur seperti lipatan, sesar, 

dan kekar (Sampurna dan Samodra, 1997). Salah satu sesar yang berada di daerah 
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Pacitan adalah Sesar Grindulu. Sesar Grindulu merupakan sesar aktif yang terbentuk 

awal Miosen dengan orientasi barat daya-timur laut (Gultaf et al., 2015). 

 

 

 

 

 

 

 

 

 

           Gambar 12. Pegunungan Selatan Bagian Barat dan Timur (Bemmelen, 1949) 

 

   

 

 

 

 

 

   

       Gambar 13. Peta Geologi Daerah Penelitian (Samodra et al., 1992) 
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  Berdasarkan peta geologi, daerah penelitian yang ditunjukkan pada Gambar 13 

terdiri atas beberapa formasi batuan antara lain: Formasi Toma,  Formasi Tmj, 

Formasi Oyo, Formasi Qa, dan Formasi Tmwl (Samodra et al., 1992). Untuk susunan 

formasi dari yang paling tua ke paling muda yaitu Formasi Arjosari (Toma), Formasi 

Jaten (Tmj), Formasi Oyo (Tmo), Formasi Wonosari (Tmwl) dan Formasi Alluvium 

(Qa) yang ditunjukkan pada Gambar 14. 

1. Formasi Toma (Arjosari) 

  Formasi Toma terbentuk pada Oligosen akhir hingga awal Miosen yang 

tersusun atas batu konglomerat aneka bahan, batu pasir, batu lanau, batu gamping, batu 

lempung, napal pasiran, batu pasir berbatu apung bersisipan breksi gunung api, lava, 

dan tuf.  

2. Formasi Tmj (Jaten) 

  Formasi Tmj terbentuk awal Miosen yang tersusun atas batu konglomerat, batu 

pasir konglomeratan, batu pasir tufan, batu lumpur, batu lanau lignit, serpih karbonan 

dan tuff setempat belerang.  

3. Formasi Tmo (Oyo) 

  Formasi Tmo terbentuk akhir Miosen yang tersusun atas batu pasir gampingan, 

batu pasir tufan, batu lanau gampingan, batu gamping tufan, napal pasiran dan napal 

tufan. 
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4. Formasi Tmwl (Wonosari) 

  Formasi Tmwl terbentuk akhir Miosen hingga awal Pliosen yang tersusun atas 

batu gamping terumbu, batu gamping berlapis, batu gamping berkepingan, batu 

gamping pasiran dan napal. 

5. Formasi Qa (Alluvium) 

  Formasi Qa terbentuk pada waktu Holosen yang tersusun atas kerakal, kerikil, 

pasir, lanau, lempung dan lumpur. 

 

 

 

 

 

 

          

 

     

 

 

 

                Gambar 14. Kolom Stratigrafi Daerah Penelitian (Samodra et al., 1992) 
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BAB III 

METODE PENELITIAN 

A. Waktu dan Tempat Penelitian 

Kegiatan akuisisi data geomagnet dalam penelitian ini dilakukan dengan 

mengukur besar medan magnet total pada titik-titik daerah penelitian yang telah 

ditentukan. Kegiatan akuisisi data geomagnet dilakukan selama 3 hari pada tanggal 24-

26 Agustus 2017 dengan batas wilayah penelitian 8̊1’75,02” LS sampai 8̊1’28,33” LS 

dan 111̊0’57,63” BT sampai 111̊1’24,65” BT. Daerah penelitian mencakup 2 

kecamatan, yaitu Kecamatan Pacitan dan Kecamatan Arjosari Kabupaten Pacitan 

dengan 37 titik pengukuran seperti ditunjukkan pada Gambar 15. 

 

 

 

 

 

 

 

 

           Gambar 15. Titik-Titik Pengukuran di Daerah Penelitian 
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B. Instrumen Penelitian 

Instrumen yang digunakan dalam penelitian ini terdiri dari perangkat keras dan 

perangkat lunak. Berikut merupakan perangkat keras dan perangkat lunak yang 

digunakan : 

1. Perangkat Keras 

Perangkat keras yang digunakan dalam penelitian ini antara lain: 

a)  Global Positioning System (GPS) merek Garmin tipe 78S (Gambar 16) untuk 

mengetahui koordinat dan elevasi titik penelitian. 

 

 

 

 

 

                                     Gambar 16. GPS Garmin Tipe 78S 

 

 

b) Satu set Proton Precession Magnetometer (PPM) merk Geometric jenis G-856 

yang ditunjukkan pada Gambar 17 terdiri dari (1) sensor untuk mengukur medan 

magnet, (2) console untuk mengetahui pembacaan medan magnet yang terukur, 

(3) kabel konektor untuk menghubungkan sensor dengan console, (4) tongkat 

untuk menyangga sensor saat dilakukan pengukuran. 

 

 



30 
 
 

 

 

 

 

 

                       Gambar 17. Satu Set PPM Merk Geometric Tipe G-856 

 

c) Kompas geologi (Gambar 18) untuk menunjukkan arah utara magnet. 

 

 

 

 

 

                             Gambar 18. Kompas Geologi 

 

 

d) Jam digital untuk mengetahui waktu pengukuran.  

e) Peta geologi untuk mengetahui kondisi lapangan. 

f) Laptop untuk mengolah data yang diperoleh. 

g) Kamera untuk mendokumentasikan kegiatan dan singkapan-singkapan yang 

terlihat di permukaan. 
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h) Meteran  (Gambar 19) untuk mengukur panjang singkapan batuan di lapangan. 

 

 

 

 

 

                                        Gambar 19. Meteran 

 

 

i) Palu geologi (Gambar 20) untuk mengambil sampel batuan di lapangan. 

 

 

 

 

 

 

                                      Gambar 20. Palu Geologi 

 

j) Lembar kerja untuk mencatat data yang diperoleh, seperti koordinat titik 

penelitian, waktu pengukuran, nilai medan magnet yang terukur, kondisi cuaca 

dan kondisi lingkungan. 
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2. Perangkat Lunak 

Perangkat lunak atau software yang digunakan dalam penelitian ini antara lain: 

a) Surfer 12 untuk membuat desain survei, model kontur data penelitian, serta 

mengkonversi koordinat. 

b) Microsoft Excel untuk mengolah data yang diperoleh, seperti perhitungan 

koreksi IGRF, koreksi variasi harian, nilai anomali medan magnet. 

c) Microsoft Office 2017 untuk menyusun data. 

d) Global Mapper 13 untuk membuat desain survei dan input koordinat ke GPS. 

e) Coordinator-Collect Coordinate untuk mengetahui jalur menuju titik penelitian. 

f) Oasis Montaj 6.4.2 untuk melakukan reduksi ke kutub, kontinuasi ke atas, 

penyayatan, dan pemodelan. 

g) Magblox untuk memasukkan data geologi daerah penelitian sebelum diolah 

menjadi model 3D. 

h) Bloxer unuk mengedit pemodelan 3D dan mengubah format pemodelan dari 

layer-layer agar dapat diolah pada software Rockwork.  

i) Rockwork  untuk pembuatan model 3D. 

 

C. Metode Penelitian 

Penelitian yang dilakukan memiliki tahapan yang ditunjukkan pada diagram 

alir (Gambar 21). 
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                                     Gambar 21. Diagram Alir  Penelitian 
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D. Akuisisi Data Medan Magnet 

Proses akuisisi data medan magnet diawali dengan mengkalibrasi alat, yaitu 

dengan melakukan proses tuning atau memilih sinyal (signal strength) paling kuat yang 

sesuai dengan nilai medan magnet di kawasan daerah penelitian. Nilai medan magnet 

di kawasan Sesar Mayor Grindulu bervariasi antara 45.062- 45.102 nT. 

Akuisisi data dalam penelitian ini menggunakan metode looping dengan satu 

sensor. Dalam metode ini, satu sensor berfungsi untuk merekam data nilai medan 

magnet di titik base maupun nilai medan magnet di titik-titik penelitian. 

Desain survei titik-titik penelitian berjumlah 37 titik dengan jarak antar titik 

500-1000 m. Beberapa titik penelitian yang mengalami offside (pergeseran titik) 

dikarenakan dekat dengan benda-benda yang memiliki kemagnetan besar seperti tiang 

listrik dan jembatan. Untuk daerah dengan medan yang ekstrim sehingga menyulitkan 

proses akuisisi data, maka titik pengukuran ditempatkan pada daerah yang mudah 

dijangkau dan jauh dari gangguan, asalkan sudah dapat mewakili formasi batuan yang 

terdapat pada peta geologi.  

Proses akuisisi data medan magnet di awal titik penelitian dilakukan dengan 

setting pada serangkaian alat PPM. Kemudian indikator N (north) pada sensor 

diarahkan ke  arah utara magnet dengan menggunakan kompas. Setelah itu dilakukan 

pembacaan nilai medan magnet yang terukur di setiap titik penelitian sebanyak 3 atau 

5 kali pada console. Pengukuran nilai medan magnet di setiap titik pengukuran 

membutuhkan waktu sekitar 5 menit. Pembacaan nilai medan magnet yang berulang 
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kali tersebut diberi selang waktu agar proton-proton yang berada dalam sensor tersebut 

kembali berpresesi. Nilai medan magnet kemudian dicatat dalam lembar kerja dan 

diberi keterangan mengenai kondisi lingkungan di sekitar titik penelitian. 

E. Pengolahan Data 

Pengukuran nilai medan magnet di lapangan berupa nilai medan magnet total 

yang kemudian dilakukan koreksi IGRF dan variasi harian untuk mendapatkan nilai 

anomali medan magnet di daerah penelitian. 

1. Koreksi IGRF 

Koreksi IGRF merupakan koreksi yang dilakukan untuk mendapatkan nilai 

anomali medan magnet yang sesungguhnya. Koreksi IGRF atau International 

Geographic Reference Field merupakan koreksi yang bersifat global yang datanya 

didapatkan dari website NOAA (www.ngdc.noaa.gov) seperti ditunjukkan pada 

Gambar 22. 

 

 

 

 

 

 

 

                       

                     Gambar 22. Koreksi IGRF pada website NOAA 
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2. Koreksi Variasi Harian 

Koreksi variasi harian dilakukan karena nilai medan magnet yang terukur juga 

dipengaruhi oleh aktivitas ionisasi di atmosfer. Koreksi variasi harian dilakukan 

berdasarkan persamaan 7.                                                                                                                   

3. Reduksi ke kutub 

Reduksi ke kutub merupakan proses untuk menghilangkan pengaruh deklinasi 

dan inklinasi dari data medan magnet. Proses reduksi ke kutub ini dilakukan agar nilai 

medan magnet yang bersifat dipole menjadi monopole sehingga anomali medan magnet 

lebih jelas terlihat. Proses reduksi ke kutub ini menggunakan software Oasis Montaj 

6.4.2. 

4. Kontinuasi ke atas 

Kontinuasi ke atas merupakan proses pemfilteran data anomali medan magnet 

terhadap ketinggian. Hal ini berfungsi untuk menghilangkan nilai anomali lokal atau  

anomali yang berasal dari sumber-sumber di permukaan sehingga dapat memperjelas 

nilai anomali regional yang ditunjukkan oleh pola konturnya. Proses kontinuasi ke atas 

dilakukan menggunakan software Oasis Montaj 6.4.2 setelah proses reduksi ke kutub. 

5. Pemodelan 2D 

Pemodelan 2D dilakukan setelah diperoleh kontur anomali medan magnet yang 

telah dikontinuasi ke atas. Pemodelan ini dilakukan untuk memprediksi susunan 

struktur batuan bawah permukaan secara 2D. Pemodelan dilakukan dengan software 

Oasis Montaj 6.4.2. Data yang digunakan sebagai dasar pembuatan model 2D adalah 
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plot anomali medan magnet yang sudah dikontinuasi ke atas pada ketinggian 1000 m 

dengan mempertimbangkan keteraturan bentuk kontur yang terbentuk ketika trial and 

errors. Sebelum dilakukan pemodelan, data anomali medan magnet disayat sesuai 

dengan target penelitian. Proses penyayatan dilakukan untuk mendapatkan sampel nilai 

anomali medan magnet yang akan dimodelkan. Pada penelitian ini dibuat model 2D 

dengan lima sayatan yang disesuaikan dengan target penelitian dan informasi geologi 

di sekitarnya. 

6. Pemodelan 3D 

Pemodelan 3D dilakukan setelah pemodelan 2D selesai. Hal ini dikarenakan 

nilai suseptibilitas yang akan dimasukkan saat pemodelan 3D disesuaikan dengan 

suseptibilitas dari model 2D. Pada pemodelan 3D yang digunakan sebagai kontur awal 

yang akan disayat adalah kontur anomali medan magnet hasil reduksi ke kutub. 

Software-software yang digunakan dalam pemodelan 3D ini adalah Rockwork, 

Magblox, dan Bloxer. Sebelum pemodelan dengan software Rockwork, data anomali 

medan magnet dianalisis dengan menggunakan software Magblox, dan Bloxer. 

Software Magblox digunakan untuk memasukkan informasi geologi seperti koordinat 

lokasi (koordinat x dan y dalam kilometer), jarak antar titik pengukuran, nilai dugaan 

kedalaman batuan dan nilai IGRF rata-rata. Setelah memasukkan data yang diperlukan, 

maka software Magblox akan mengolah data tersebut menjadi model dalam bentuk 

layer-layer. Setelah itu, data dalam layer dapat diedit lagi dengan software Bloxer 

menyesuaikan dengan model 2D. Software Bloxer juga mengubah format keluaran 

software Magblox agar dapat diolah oleh software Rockwork. Tahapan terakhir adalah 
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pemodelan 3D yang dilakukan dengan software Rockwork. Seluruh informasi data 

geologi dari proses analisa akan diproses menjadi sebuah model 3D berdasarkan nilai 

suseptibilitas. 
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BAB IV 

HASIL PENELITIAN DAN PEMBAHASAN 

 

Interpretasi struktur bawah permukaan pada kawasan Sesar Mayor Grindulu 

berdasarkan pengukuran medan magnet bertujuan untuk mengetahui persebaran nilai 

anomali medan magnet, struktur bawah permukaan dan identifikasi jalur sesar tersebut. 

Alat yang digunakan untuk akuisisi medan magnet di kawasan Sesar Mayor Grindulu 

adalah Proton Precession Magnetometer (PPM) merk Geometric tipe G-856. 

 Medan magnet yang terukur dengan menggunakan PPM merupakan medan 

magnet total yang terdiri atas medan magnet utama bumi, medan magnet luar, dan 

anomali medan magnet. Anomali medan magnet menjadi target metode geomagnet 

dikarenakan anomali medan magnet merepresentasikan struktur bawah permukaan 

pada kawasan tersebut. Anomali medan magnet diperoleh dengan melakukan koreksi 

variasi harian dan IGRF pada nilai medan magnet total. Nilai anomali medan magnet 

setelah dilakukan kedua koreksi tersebut dipengaruhi oleh medan magnet regional 

maupun lokalnya. Oleh karena itu, pada hasil perhitungan nilai anomali medan magnet 

tersebut dilakukan proses reduksi ke kutub dan kontinuasi ke atas untuk memperjelas 

sumber anomali medan magnet yang menjadi target penelitian.  
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A. Medan Magnet Total 

Nilai medan magnet total hasil pengukuran di lapangan berkisar antara 44.400–

45.550 nT. Distribusi nilai medan magnet total dapat diketahui dengan melakukan 

interpolasi nilai medan magnet total pada titik-titik pengukuran yang ditunjukkan pada 

Gambar 23.  

 

 

 

 

         

 

                                                                                                                                                            

 

Gambar 23. Kontur Medan Magnet Total Daerah Penelitian  

Skala warna pada kontur di atas menunjukkan adanya klosur rendah, sedang, 

hingga tinggi. Klosur rendah sebagian besar berada di bagian selatan daerah penelitian 

dengan nilai medan magnet total hasil pengukuran 44.400-44.800 nT. Klosur sedang 

sebagian besar berada di bagian tengah hingga bagian utara daerah penelitian dengan 

nilai medan magnet total berkisar antara 44.800-45.100 nT. Klosur tinggi sebagian 
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besar berada di bagian barat daya daerah penelitian dengan nilai medan magnet total 

berkisar antara 45.100-45.550 nT.  

Gambar 23 belum dapat menunjukkan pengaruh geologi regional daerah 

penelitian terhadap medan magnet total, sehingga kontur medan magnet total tersebut 

perlu di-overlay dengan batas formasi batuan pada daerah penelitian yang ditunjukkan 

pada Gambar 24. 

 

 

 

 

 

 

       

            Gambar 24. Kontur Medan Magnet Total di-overlay dengan Peta Geologi 

Kawasan Sesar Mayor Grindulu terdiri atas lima formasi batuan antara lain: 

Formasi Alluvium (Qa), Formasi Oyo (Tmo), Formasi Wonosari (Tmwl), Formasi 

Jaten (Tmj) dan Formasi Arjosari (Toma). Formasi Alluvium (Qa) terdiri atas material 

kerakal, kerikil, pasir, lanau, lempung, dan lumpur. Formasi Oyo (Tmo) terdiri atas 

batu pasir gampingan, batu pasir tufan, batu lanau gampingan, batu gamping tufan, 



42 
 
 

napal pasiran, dan napal tufan. Formasi Wonosari (Tmwl) terdiri atas batu gamping 

terumbu, batu gamping berlapis, batu gamping berkepingan, batu gamping pasiran dan 

napal. Formasi Jaten (Tmj) terdiri atas batu konglomerat, batu pasir konglomeratan, 

batu pasir tufan, batu lumpur, batu lanau, lignit, serpih karbonan, dan tuf serta 

mengandung sedikit belerang, sedangkan Formasi Arjosari (Toma) terdiri atas 

konglomerat aneka bahan, batu pasir, batu lanau, batu gamping, batu lempung, napal 

pasiran, batu pasir berbatu apung bersisipan breksi gunung api, lava, dan tuf. 

Gambar 24 menunjukkan bahwa klosur medan magnet total di kawasan jalur 

Sesar Mayor Grindulu bervariasi dari klosur rendah, sedang, dan tinggi. Klosur rendah 

sebagian besar berada pada Formasi Qa, klosur sedang mencakup beberapa formasi di 

antaranya Formasi Tmo, Tmwl dan Toma, sedangkan klosur tinggi berada pada 

Formasi Tmj. 

Formasi Qa memiliki nilai medan magnet rendah dikarenakan Formasi Qa ini 

merupakan hasil endapan sungai dengan material atau batuan yang memiliki nilai 

suseptibilitas rendah seperti kerakal, kerikil, pasir, lanau, lempung, dan lumpur. 

Formasi Tmo, Tmwl, dan Toma memiliki nilai medan magnet sedang dikarenakan  

formasi ini terdiri atas berbagai material penyusun seperti batu pasir, batu lempung, 

batu gamping yang memiliki nilai suseptibilitas rendah dan batu tuf, batu breksi yang 

memiliki nilai suseptibilitas tinggi. Formasi Tmj memiliki nilai medan magnet  tinggi 

dikarenakan pada formasi ini terdapat intrusi basalt yang muncul hingga permukaan 
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sepanjang 12,4 m, dimana batuan tersebut memiliki nilai suseptibilitas yang lebih 

tinggi dibandingkan dengan batuan sedimen yang mendominasi daerah penelitian. 

B. Koreksi Topografi  

Koreksi topografi atau ketinggian dilakukan untuk mengetahui pengaruh 

ketinggian atau elevasi titik pengukuran terhadap nilai medan magnet total. Elevasi titik 

pengukuran di daerah penelitian berkisar antara 20 m sampai 420 m. Untuk mengetahui 

ada tidaknya keterkaitan antara topografi terhadap medan magnet total di daerah 

penelitian dilakukan sayatan pada koordinat yang sama pada kedua kontur yang 

ditunjukkan pada Gambar 25. 

  

 

 

 

 

 

                                                                                                                                     

 

(a)        (b) 

Gambar 25. (a) Kontur Topografi, (b) Kontur Medan Magnet Total Daerah Penelitian 
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                                                              (a) 

   

 

 

 

 

 

 

 

 

 

 

          (b) 

 

Gambar 26. (a) Profile Sayatan Topografi, (b) Profile Sayatan Medan Magnet Total 

 

 

Berdasarkan profile sayatan topografi dan medan magnet total terlihat tidak ada 

hubungan antara ketinggian daerah penelitian dengan nilai medan magnet terukur. Hal 

tersebut ditunjukkan oleh hasil sayatan AA’ pada kontur topografi dan medan magnet 

total pada Gambar 26. Sebagai contoh pada jarak 0-622 m pada profile sayatan 

topografi nampak daerah yang lebih tinggi namun menghasilkan nilai medan magnet 

yang tidak besar. Pada profile sayatan topografi pada jarak 622-1014 m dengan elevasi 

yang lebih rendah dibandingkan dengan jarak 0-622 m menghasilkan nilai medan 
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magnet total yang lebih besar. Oleh karena itu, tidak perlu dilakukan proses reduksi ke 

bidang datar karena antara topografi dan nilai medan magnet total tidak berhubungan. 

C. Medan Magnet Regional 

Medan magnet regional merupakan medan magnet utama bumi yang berubah 

terhadap waktu sehingga untuk menyeragamkan nilai-nilai medan magnet utama bumi 

dibuat standar nilai yang disebut dengan International Geomagnetic Reference Field 

(IGRF). Nilai IGRF tersebut diperbaharui setiap 5 tahun sekali dimana nilai-nilai 

tersebut diperoleh dari hasil pengukuran rata-rata pada daerah luasan 1 juta km2.  

 

 

 

 

 

 

 

 

 

 

 

              

 

 

 Gambar 27. Kontur IGRF Daerah Penelitian 

 

Model IGRF menunjukkan nilai medan magnet utama bumi, secara umum yang 

dapat diakses melalui website NOAA. Letak astronomi Indonesia yang berada di 

selatan ekuator memberikan nilai IGRF yang berkisar ±45.000 nT. Nilai IGRF yang 
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mencakup daerah penelitian ditunjukkan pada Gambar 27 yang berkisar antara 45.062-

45.102 nT.  

Kontur IGRF daerah penelitian menunjukkan bahwa bagian selatan memiliki 

klosur yang lebih tinggi dibandingkan dengan bagian utara daerah penelitian. Rata-rata 

nilai IGRF di daerah penelitian adalah 45.084 nT.  

 

D. Medan Magnet Luar 

 

Medan magnet luar merupakan medan magnet yang berasal dari pengaruh luar 

bumi yang disebabkan oleh adanya arus listrik di ionosfer. Medan magnet luar ini 

mempengaruhi nilai medan magnet total hasil pengukuran, sehingga dilakukan koreksi 

variasi harian untuk memisahkan medan magnet total dan anomali medan magnet. 

Koreksi variasi harian berfungsi untuk mereduksi pengaruh medan magnet luar pada 

saat pengukuran. Berdasarkan hasil perhitungan, koreksi variasi harian pada kawasan 

Sesar Mayor Grindulu  bervariasi antara -164 nT hingga 83 nT. 

 

 

 

 

 

 

 

 

 

 

Gambar 28. Data Plot Indeks Dst pada Tanggal 24-26 Agustus 2017 
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Nilai medan magnet total pada tanggal 24-26 Agustus 2017 berdasarkan ISGI 

(International Service of Geomagnetic Indices) tidak dipengaruhi oleh aktivitas badai 

magnetik. Gambar 28 menunjukkan nilai indeks Dst pada tanggal 24-26 Agustus 2017. 

 

 

 

 

 

 

 

 

 

 

 

 

 

(a)                                                                 (b) 

 

Gambar 29. (a) Kontur Medan Magnet Total, (b) Kontur Medan Magnet Total 

yang dikoreksi Variasi Harian 

 

 

Gambar 29 (a) menunjukkan kontur medan magnet total dan Gambar 29 (b) 

menunjukkan kontur medan magnet total yang telah dikoreksi variasi harian. Setelah 

dilakukan koreksi variasi harian, peta kontur medan magnet total tidak menunjukkan 

adanya perubahan yang signifikan. Hal ini menunjukkan medan magnet total yang 

terukur di lapangan tidak dipengaruhi secara signifikan oleh medan magnet luar. 
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E. Anomali Medan Magnet 

Anomali medan magnet merupakan nilai residu yang dihasilkan dari koreksi 

pada nilai medan magnet total. Anomali medan magnet mencerminkan batuan yang 

mengandung mineral-mineral bersifat magnetik yang berada di bawah permukaan. 

Gambar 30 menunjukkan pola persebaran nilai anomali medan magnet di daerah 

penelitian yang berkisar antara -700 nT sampai 400 nT. Nilai anomali medan magnet 

pada daerah penelitian memiliki rentang nilai yang cukup lebar dikarenakan adanya 5 

variasi formasi batuan yang berbeda.  

 

 

 

 

 

 

 

 

 

 

 

 

 

    Gambar 30. Kontur Anomali Medan Magnet di Daerah Penelitian 

 

Gambar 30 menunjukkan bahwa di daerah penelitian terdapat klosur rendah, 

sedang hingga tinggi. Nilai anomali medan magnet yang dihasilkan berkorelasi dengan 

mineral-mineral magnetik penyusun batuan di daerah penelitian, dimana batuan yang 
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tersusun atas banyak mineral-mineral magnetik akan menyumbangkan nilai 

suseptibilitas yang besar dan sebaliknya. Formasi Qa di daerah penelitian didominasi 

oleh endapan pasir sungai dan batu pasir yang memiliki rentang nilai suseptibilitas 

rendah dengan rentang nilai anomali medan magnet -700 nT sampai -400 nT. Pada 

Formasi Toma, Tmwl, dan Tmo di daerah penelitian terdapat berbagai macam batuan 

seperti batu gamping, batu pasir, batu lempung, batu breksi dan batu tuf sehingga 

dihasilkan nilai anomali medan magnet yang lebar dengan rentang nilai -400 nT sampai 

50 nT, sedangkan pada Formasi Tmj daerah penelitian terdapat batu pasir 

konglomeratan dan intrusi basalt yang muncul hingga permukaan dengan rentang nilai 

anomali medan magnet berkisar antara 50 nT sampai 400 nT. 

F. Reduksi ke Kutub 

Reduksi ke kutub atau Reduction to pole (RTP) merupakan tahapan untuk 

memposisikan benda penyebab anomali secara tepat berada pada arah vertikal dengan 

mengubah arah magnetisasinya. Proses  ini dilakukan dengan mengubah nilai deklinasi 

0.91° dan inklinasi -33° pada daerah penelitian menjadi berada di daerah kutub yang 

memiliki nilai deklinasi 0° dan inklinasi 90°. Hal tersebut menjadikan medan magnet 

yang awalnya bersifat dipole menjadi monopole. Data anomali medan magnet yang 

telah dilakukan proses RTP ditunjukkan pada Gambar 31. 

Setelah dilakukan proses RTP, pola kontur anomali medan magnet di daerah 

penelitian mengalami perubahan, namun masih dalam rentang skala antara -700 nT 

sampai 400 nT. Klosur tinggi yang berada pada bagian barat daya cenderung ke tengah 
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dan memiliki rentang nilai anomali medan magnet -50 nT sampai 400 nT. Klosur 

sedang tersebar di bagian tengah daerah penelitian dan memiliki rentang nilai anomali 

medan magnet berkisar antara -300 nT sampai -50 nT. Klosur rendah berada tepat di 

barat daya dan selatan daerah penelitian dengan rentang nilai anomali medan magnet 

berkisar antara -700 nT sampai -300 nT. 

 

 

 

 

 

 

 

 

 

 

 

 

 

       Gambar 31. Kontur Anomali Medan Magnet yang telah di RTP 

 

 

G. Kontinuasi ke Atas 

Kontinuasi ke atas dilakukan melalui proses low pass filtering untuk 

memisahkan anomali lokal dan regional daerah penelitian. Proses ini dilakukan pada 

ketinggian 200 m, 400 m, 600 m, 800 m, dan 1000 m. Pada ketinggian 1000 m pola 

kontur anomali medan magnet sudah tidak berubah secara signifikan sehingga sudah 

mewakili anomali regional di daerah penelitian.  Oleh karena itu, peta kontur anomali 
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medan magnet hasil kontinuasi ke atas pada ketinggian 1000 m digunakan pada 

pengolahan lebih lanjut untuk pemodelan 2D dan 3D. Proses kontinuasi ke atas pada 

berbagai ketinggian ditunjukkan pada Gambar 32. Peta kontur anomali medan magnet 

hasil dari kontinuasi ke atas pada ketinggian 1000 m menggambarkan keberadaan 

batuan yang memiliki nilai suseptibilitas tinggi dan rendah. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 32. Hasil Kontur Kontinuasi ke Atas (a) Ketinggian 200 m, (b) Ketinggian 

400 m, (c) Ketinggian 600 m, (d) Ketinggian 800 m, (e) Ketinggian 1000 m 

 

Klosur tinggi menggambarkan keberadaan batuan yang memiliki nilai 

suseptibilitas tinggi seperti batuan beku, sedangkan untuk klosur rendah 
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menggambarkan keberadaan batuan yang memiliki nilai suseptibilitas rendah seperti 

batuan sedimen. Untuk menjelaskan variasi susunan lapisan-lapisan batuan bawah 

permukaan dilakukan pemodelan 2D dan 3D dengan menggunakan kontur anomali 

medan magnet hasil kontinuasi ke atas pada ketinggian 1000 m. 

H. Pemodelan 2D 

Untuk pemodelan 2D dilakukan sayatan pada jalur-jalur tertentu sesuai dengan 

tujuan penelitian. Tujuan penelitian ini adalah untuk menginterpretasi struktur bawah 

permukaan  di jalur Sesar Mayor Grindulu. Sesar Mayor Grindulu memiliki 

karakteristik sesar geser yang berorientasi barat daya-timur laut (Gultaf et al., 2015).  

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 33. Sayatan pada Anomali Medan Magnet Hasil Kontinuasi ke Atas 

dengan Ketinggian 1000 m 
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Karakteristik sesar geser adalah tidak menunjukkan adanya kontras nilai 

suseptibilitas pada jalur sesar, sehingga akan sulit untuk diidentifikasi. Untuk 

memperjelas struktur bawah permukaan di jalur sesar maka dilakukan penyayatan 

dengan 3 sayatan memotong dan 1 sayatan sejajar dengan sesar seperti yang 

ditunjukkan pada Gambar 33.        

 Pembuatan model 2D pada sayatan AA’, BB’, dan CC’ merujuk pada Peta 

Geologi Lembar Pacitan. Pada peta ini sayatan AB yang berada di dekat daerah 

penelitian melewati 5 formasi dengan kedalaman 500 m. Peta Geologi Lembar Pacitan 

menunjukkan bahwa Formasi Toma merupakan batuan dasar di daerah penelitian. 

Lapisan di atasnya adalah Formasi Tmj kemudian di atasnya lagi Formasi Tmo yang 

berselingan dengan Formasi Tmwl. Untuk lapisan yang paling atas adalah Formasi Qa 

seperti yang ditunjukkan Gambar 13.  

Pembuatan model 2D untuk sayatan DD’ merujuk pada penelitian Gultaf et al. 

(2015), dimana sayatan AA’ (Gambar 34) melewati 7 formasi batuan dimana batuan 

dasar di daerah sayatan adalah Formasi Toma, Formasi Tomm yang berselingan dengan 

Formasi Tomw, sedangkan formasi yang mencakup daerah penelitian terdiri atas 5 

formasi yang susunannya sama dengan sayatan AB yang ditunjukkan pada Gambar 13. 

Pemodelan 2D memiliki 2 bagian utama yaitu bagian atas yang menunjukkan 

nilai anomali medan magnet dan bagian bawah yang menunjukkan model struktur 

batuan bawah permukaan. Pemodelan 2D ini terdiri atas blok-blok batuan yang 

memiliki nilai suseptibilitas dan kedalaman yang beragam. Selain itu pemodelan 2D 
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ini juga mempertimbangkan fakta-fakta yang berada di lapangan dengan melakukan 

sampling batuan di daerah penelitian. Kesesuaian referensi dengan model ditunjukkan 

dalam angka error yang terletak di bagian kiri. Pemodelan sayatan AA’ memiliki nilai 

error 4,6, pemodelan sayatan BB’ memiliki nilai error 3,7, pemodelan sayatan CC’ 

memiliki 5,7 dan pemodelan DD’ memiliki error 6,1. 

 

 

 

 

 

 

 

 

 

 

  

    

 

   Gambar 34. Pemodelan 2D Sayatan AA’ pada Peta Geologi Gultaf et al. (2015) 



55 
 
 

 

 

 

 

         

 

 

 

 

 

 

 

 

 

 

 

 

a 
b
 

c 
d
 



56 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

c 

b
 

a 



57 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

c 
b

 
a 



58 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



59 
 
 

 

 

 

                                                   

               (a)                                            (b) 

 

 

           

           

 

                          (c)                  (d) 

Gambar 39. Verifikasi Batuan di Lapangan pada Sayatan AA’ (a) Batu Pasir,           

(b) Batu Gamping, (c) Batu Intrusi Basalt, (d) Batu Pasir 

 

 

 

 

 

    (a)                                      (b)                                    (c) 

Gambar 40. Verifikasi Batuan di Lapangan pada Sayatan BB’ (a) Batu Pasir,                     

(b) Batu Gamping, (c) Batu Pasir 
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 (a)                                       (b)                                   (c) 

Gambar 41. Verifikasi Batuan di Lapangan pada Sayatan CC’ (a) Endapan Pasir,            

(b) Batu Gamping, (c) Batu Lempung 

 

Pemodelan 2D untuk sayatan AA’ ditunjukkan pada Gambar 35. Sayatan AA’ 

melewati 3 formasi batuan yaitu dari ujung selatan Formasi Qa, kemudian bagian 

tengah Formasi Toma dan paling utara adalah Formasi Tmj. Pada Formasi Qa di bagian 

selatan daerah penelitian terdapat pasir dan batu pasir pada kedalaman 0 m hingga 90 

m dengan rentang nilai suseptibilitas (0-2)×10-3. Pada bagian tengah sayatan terdapat 

Formasi Toma yang terdiri atas batu gamping pada kedalaman 0 m hingga 315 m 

dengan rentang nilai suseptibilitas (2,2-2,8)×10-3. Untuk batuan penyusun di bawahnya 

diperkirakan batu tuf pada kedalaman 316 m hingga 523 m dengan rentang nilai 

suseptibilitas (5,1-6,4)×10-3 dan batu breksi pada kedalaman 524 m hingga 557 m 

dengan rentang nilai suseptibilitas (33-68)×10-3, sedangkan pada Formasi Tmj terdapat 

batu pasir pada kedalaman 0 m hingga 107 m dengan rentang nilai suseptibilitas (0-

2)×10-3 dan intrusi basalt sepanjang 12,4 m di bagian tengah pada kedalaman 0 m 

hingga 557 m dengan rentang nilai suseptibilitas (12,5-165)×10-3. Berdasarkan 
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pemodelan 2D pada sayatan AA’ ini diperkirakan keberadaan sesar memotong lapisan 

batu pasir, batu gamping, batu  tuf dan batu breksi di daerah penelitian. 

Tabel 6. Nilai Suseptibilitas, Kedalaman Batuan dan Formasi Batuan di Daerah 

Penelitian Berdasarkan Hasil Pemodelan 2D 

 

Pemodelan 2D sayatan BB’ ditunjukkan pada Gambar 36. Sayatan BB’ 

melewati 2 formasi batuan dari bagian selatan yaitu Formasi Qa dan bagian utara yaitu  

Formasi Toma. Bagian selatan daerah penelitian pada Formasi Qa terdapat pasir dan 

No. Model Suseptibilitas Batuan 

 (Formasi Batuan) 

Kedalaman (m) 

1. 
 

(0-2)×10-3 Pasir (Alluvium) (0 sampai 91) 

2. 
 

(0-2)×10-3 Batu Pasir 

(Alluvium) 

(0 sampai 211) 

3. 
 

(2,2-2,8)×10-3 Batu Gamping 

(Arjosari) 

(0 sampai 336) 

4. 
 

(5,1-6,4)×10-3 Batu Tuf (Arjosari) (38 sampai 523) 

5. 
 

(33-68)×10-3 Batu Breksi 

(Arjosari) 

(38 sampai 665) 

6. 
 

(12,5-165)×10-3 Batu intrusi basalt (0 sampai 557) 

7.      (2,2-2,8)×10-3 Batu lempung 

(Arjosari) 

(0 sampai 203) 

8.  (2,2-2,8)×10-3 Formasi Oyo (Tmo) (0 sampai 104) 

9.  (5,1-68)×10-3 Formasi Arjosari 

(Toma) 

(0 sampai 775) 

10.  (2,1-3,9)×10-3 Formasi Jaten (Tmj) (0 sampai 192) 

11.  (0-2)×10-3 Formasi Alluvium 

(Qa) 

(0 sampai 150) 
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batu pasir pada kedalaman 0 m hingga 166 m dengan rentang nilai suseptibilitas (0-

2)×10-3, sedangkan pada Formasi Toma terdapat batu gamping pada bagian tengah dari 

kedalaman 0 m hingga 336 m dengan rentang suseptibilitas  (2,2-2,8)×10-3 dan batu 

pasir pada kedalaman 0 m hingga 211 m di bagian utara sayatan BB’ daerah penelitian 

dengan rentang nilai suseptibilitas (0-2)×10-3. Untuk batuan penyusun di bawahnya 

diperkirakan batu tuf  pada kedalaman 212 m hingga 465 m dengan rentang nilai 

suseptibilitas (5,1-6,4)×10-3 dan batu breksi pada kedalaman 466 m hingga 665 m 

dengan rentang nilai suseptibilitas (33-68)×10-3. Berdasarkan pemodelan 2D pada 

sayatan BB’ ini diperkirakan keberadaan sesar memotong lapisan batu gamping, batu  

tuf dan batu breksi di daerah penelitian. 

Pemodelan 2D sayatan CC’ ditunjukkan pada Gambar 37. Sayatan ini melewati 

2 formasi yaitu pada bagian selatan terdapat Formasi Qa dan bagian tengah hingga 

paling utara termasuk Fomasi Toma. Pada Formasi Qa terdapat endapan pasir sungai 

dari kedalaman 0 m hingga 91 m dengan rentang nilai suseptibilitas (0-2)×10-3. Lapisan 

di bawah endapan pasir diperkirakan terdapat batu pasir pada kedalaman 92 m hingga 

208 m dengan rentang nilai suseptibilitas (0-2)x10-3, sedangkan pada Formasi Toma 

bagian tengah sayatan ini dijumpai batu gamping pada kedalaman 0 m hingga 292 m 

dengan rentang nilai suseptibilitas (2,2-2,8)×10-3, sedangkan batu lempung pada bagian 

utara sayatan ini diperkirakan berada pada kedalaman 0 m hingga 203 m dengan 

rentang nilai suseptibilitas (2,2-2,8)×10-3. Untuk batuan penyusun di bawahnya 

diperkirakan batu tuf  pada kedalaman 38 m hingga 400 m dengan rentang nilai 
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suseptibilitas (5,1-6,4)×10-3 dan batu breksi pada kedalaman 38 m hingga 639 m 

dengan rentang nilai suseptibilitas (33-68)×10-3. Berdasarkan pemodelan 2D pada 

sayatan CC’ ini diperkirakan keberadaan sesar memotong lapisan batu gamping, batu  

tuf dan batu breksi di daerah penelitian. 

Pemodelan 2D sayatan DD’ ditunjukkan pada Gambar 38. Sayatan ini melewati 

4 formasi yaitu Formasi Tmo, Formasi Toma, Formasi Tmj dan Formasi Qa. Pada 

bagian barat dimulai dengan Formasi Tmo, Formasi Toma, Formasi Tmj dan yang 

paling timur adalah Formasi Qa. Formasi Tmo daerah penelitian didominasi oleh batu 

gamping yang diperkirakan berada pada kedalaman 0 m hingga 104 m dengan rentang 

nilai suseptibilitas (2,2-2,8)×10-3. Formasi Toma didominasi oleh batuan yang berasal 

dari material gunung api seperti breksi vulkanik dan batu tuf dari kedalaman 0 m hingga 

775 m. Formasi Tmj didominasi oleh batu pasir pada kedalaman 0 m hingga 192 m 

dengan rentang nilai suseptibilitas (2,1-3,9)×10-3, sedangkan Formasi Qa didominasi 

oleh endapan pasir, lumpur, lempung, kerakal, kerikil pada kedalaman 0 m hingga 150 

m dengan rentang nilai suseptibilitas (0-2)×10-3. 

Pada Formasi Tmo daerah penelitian ditemukan singkapan batu gamping yang 

dimungkinkan genesanya terendapkan di lingkungan laut kemudian mengalami 

pengangkatan sehingga muncul di permukaan. Hal ini berkorelasi dengan daerah 

penelitian yang dekat dengan zona Pantai Selatan, dimana geologi daerah Pacitan dan 

sekitarnya berkaitan erat dengan proses pengangkatan aktif Pantai Selatan yang 

ditunjukkan dengan banyak tersingkapnya batuan gamping di daerah penelitian seperti 
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pada Formasi Oyo. Pada Formasi Qa daerah penelitian terdapat material seperti 

kerakal, kerikil, pasir, batu pasir, lanau, lempung dan lumpur yang dimungkinkan 

berasal dari hasil endapan Sungai Grindulu maupun aktivitas marin. 

 Pada Formasi Toma daerah penelitian terdapat batu tuf, batu gamping, batu 

lempung, dan breksi vulkanik. Formasi ini didominasi oleh material gunung api seperti 

breksi vulkanik yang dimungkinkan terbentuk dari longsoran material yang dipicu oleh 

tingginya densitas, kemudian mengalami pelapukan dan tertransport ke lingkungan 

pengendapan. Untuk batu tuf yang termasuk dalam batuan piroklastik dimungkinkan 

berasal dari lemparan gunung api tersier di dekat daerah penelitian yang kemudian 

terbawa oleh angin dan jatuh secara perlahan, terendapkan, kemudian terkompaksi 

menjadi batuan tuf. 

 Pada Formasi Tmj daerah penelitian ditemukan batu pasir konglomeratan, dan 

intrusi basalt. Batu pasir yang terbentuk pada formasi ini dimungkinkan  berasal dari 

sedimentasi lapukan batuan dari Formasi Toma, yang terendapkan pada suatu 

lingkungan dan mengalami kompaksi sehingga terbentuk batu pasir, sedangkan intrusi 

basalt berasal dari aktivitas gunung api tersier di dekat daerah penelitian yang terbentuk 

di bawah permukaan kemudian menerobos batuan di sekitarnya sehingga muncul di 

permukaan. 
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I. Identifikasi Jalur Sesar 

Identifikasi jalur sesar dilakukan berdasarkan model suseptibilitas batuan 2D 

dan 3D, analisis Second Vertical Derivatif (SVD), survey geologi serta referensi. 

Berdasarkan kontras nilai suseptibilitas batuan, sesar normal (baik naik atau turun) 

memiliki karakter kontras yang jelas. Kontras tersebut mengindikasikan adanya  

perbedaan blok batuan di sekitar jalur sesar, sedangkan untuk karakter sesar geser 

kontras tersebut tidak terlihat di sekitar jalur sesar.  

Pemodelan 3D nilai suseptibilitas dilakukan dengan tujuan untuk 

mempermudah interpretasi kontras nilai suseptibilitas batuan di daerah penelitian yang 

ditunjukkan pada Gambar 42. Nilai suseptibilitas batuan tersebut merepresentasikan 

mineral-mineral magnetik yang menyusun batuan di daerah penelitian. Daerah Pacitan 

yang mencakup daerah penelitian tersusun atas berbagai formasi batuan antara lain 

Formasi Tmo, Formasi Qa, Formasi Toma, dan Formasi Tmj.  Berbagai formasi batuan 

tersebut menyumbangkan nilai suseptibilitas masing-masing. 

Lapisan paling atas daerah penelitian sebagian besar tersusun atas material atau 

batuan seperti pasir, batu pasir, batu lempung, dan batu gamping yang memiliki nilai 

suseptibilitas rendah berkisar 0-0,00386 yang ditunjukkan dengan warna magenta 

hingga biru muda. Material atau batuan-batuan tersebut berasal dari berbagai formasi 

batuan di daerah penelitian seperti Formasi Tmo, Formasi Qa, Formasi Toma, dan 

Formasi Tmj. Pada bagian barat daerah penelitian terdapat intrusi basalt yang memiliki 

nilai suseptibilitas tinggi berkisar 0,00986-0,01586 yang ditunjukkan dengan warna 

hijau hingga merah. Intrusi tersebut diperkirakan dikontrol oleh adanya patahan atau 
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sesar yang berada di daerah penelitian, dimana patahan tersebut menjadi jalur naiknya 

magma yang kemudian membeku hingga permukaan dan menjadi intrusi basalt. Untuk 

lapisan di bawahnya diperkirakan berasal dari Formasi Toma daerah penelitian yaitu 

batu tuf dari hasil lemparan gunung api tersier dan batu breksi vulkanik yang 

merupakan hasil longsoran material yang telah mengalami pelapukan dan pengendapan 

dengan nilai suseptibilitas 0,00386-0,00786 yang ditunjukkan dengan warna biru tua 

hingga toska.  

 Menurut informasi, keberadaan Sesar Mayor Grindulu diperkirakan memiliki 

karakteristik sesar geser dan berada pada formasi batuan yang sama (Formasi Toma) 

(Gultaf et al., 2015). Berdasarkan penelitian dengan metode gravitasi (Indrianti, 2013), 

diperkirakan bahwa Sesar Mayor Grindulu memiliki karakteristik sesar geser yang 

mencapai batuan dasar (basement) dan tidak terlihat kontras nilai densitas batuannya. 

Dengan melihat pemodelan 3D metode magnetik pada 3 sayatan memotong jalur sesar 

(AA’, BB’ dan CC’) dan 2 sayatan sejajar jalur sesar (DD’ dan EE’) juga tidak terlihat 

adanya kontras nilai suseptibilitas di sekitar jalur sesar tersebut yang ditunjukkan pada 

Gambar 43-44. Dugaan sesar geser ini didukung juga oleh interpretasi peta geologi 

(Gambar 45) dimana pada bagian timur laut daerah penelitian terdapat Formasi Toma 

yang dipisahkan oleh Sungai Grindulu. Hal ini mengakibatkan Formasi Toma di daerah 

penelitian seperti terpisah menjadi 2 blok, dimana celah antara 2 blok tersebut diisi oleh 

Formasi Qa (hancuran dari Formasi Toma itu sendiri).  
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Gambar 42. Hasil Pemodelan 3D Nilai Suseptibilitas 0-0,01586  

 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 43. Tampilan Sayatan AA’, BB’ dan CC’ pada Pemodelan 3D yang di-

overlay dengan Dugaan Jalur Sesar Mayor Grindulu 
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Gambar 44. Tampilan Sayatan DD’ dan EE’ pada Pemodelan 3D yang di-overlay 

dengan Dugaan Jalur Sesar Mayor Grindulu 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 45. Interpretasi Peta Geologi 
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SVD merupakan sebuah tools dalam pengolahan metode geomagnet yang 

berguna untuk mengetahui pola kemenerusan dan karakteristik dari suatu sesar atau 

patahan. Pengolahan SVD menggunakan anomali lokal yang diperoleh dengan cara 

mereduksi anomali regional. Pola sesar ini ditunjukkan dengan melihat kontras nilai 

turunan kedua dari anomali medan magnet (Second Vertical Derivatif) yang berada di 

sepanjang jalur sesar tersebut. Jika terdapat kontras warna yang signifikan antara blok 

bagian barat dan blok timur pada jalur sesar, maka dimungkinkan sesar di wilayah 

penelitian berupa sesar naik atau sesar turun. Namun, jika tidak terdapat kontras warna 

yang signifikan pada blok bagian barat dan timur di sepanjang jalur sesar maka 

dimungkinkan berupa sesar geser. Hasil SVD 2D ditunjukkan pada Gambar 46. 

  

 

 

 

 

 

 

 

 

                   Gambar 46. Sayatan 2D Anomali Medan Magnet Hasil SVD 
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(a)                                                            (b) 

 

 

 

 

 

 

(c)                                                            (d)                    

 

 

 

 

 

 

                                  (e)                                                             (f) 

 

Gambar 47. Nilai SVD Anomali Medan Magnet (a) Sayatan AA’,  (b) Sayatan BB’, 

(c) Sayatan CC’, (d) Sayatan DD’, (e) Sayatan EE’, (f) Sayatan FF’ 
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(a)                                                               (b) 

 

 

 

 

 

 

 

(c)                                                              (d) 

 

 

 

 

 

 

 

(e) 

Gambar 48. Nilai SVD Anomali Medan Magnet (a) Sayatan GG’, (b) Sayatan HH’ 

(c) Sayatan II’, (d) Sayatan JJ’, (e) Sayatan KK’ 
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                    Gambar 49. Hasil SVD 3D dari Anomali Medan Magnet 

 

Pada Gambar 46 terdapat sayatan AA’ hingga KK’ yang memotong jalur Sesar 

Grindulu, kemudian data dari profile sayatan tersebut ditampilkan dalam bentuk grafik 

seperti pada Gambar 47-48. Berdasarkan Peta Geologi Lembar Pacitan, Sesar Mayor 

Grindulu digambarkan sebagai sesar geser dimana blok barat dan blok timur bergerak 

relatif sejajar. Dari profile sayatan (AA’, EE’, FF’, HH’, II’, JJ’ dan KK’) pola kontur 

SVD 2D didapatkan hasil bahwa sebagian besar blok barat dan timur yang berada di 

sepanjang jalur sesar bergerak relatif sejajar. Hal ini menunjukkan bahwa Sesar Mayor 

Grindulu memiliki karakteristik sesar geser. 

Untuk memperjelas pola kemenerusan sesar maka dibuat model 3D dari kontur 

SVD yang ditunjukkan pada Gambar 49. Hasil SVD 3D dari kontur anomali medan 
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magnet menggambarkan kenampakan blok barat dan timur relatif sejajar pada 

sepanjang jalur sesar tersebut. 
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BAB V 

KESIMPULAN DAN SARAN 

A. Kesimpulan  

 Berdasarkan penelitian “Interpretasi Struktur Bawah Permukaan dan 

Identifikasi Jalur Sesar Mayor Grindulu Berdasarkan Data Anomali Medan Magnet” 

dapat diambil kesimpulan sebagai berikut: 

1.  Nilai persebaran anomali medan magnet di kawasan jalur Sesar Mayor Grindulu 

berkisar -700 nT sampai 400 nT dan terbagi menjadi klosur rendah, sedang, hingga 

tinggi. Klosur rendah sebagian besar berada pada Formasi Qa dengan rentang nilai 

anomali medan magnet berkisar  -700 nT sampai -400 nT. Klosur sedang berada 

pada Formasi Toma, Tmwl, dan Tmo dengan rentang nilai anomali medan magnet 

berkisar -400 nT sampai 50 nT. Klosur tinggi sebagian besar berada pada Formasi 

Tmj dengan rentang nilai anomali medan magnet berkisar 50 nT sampai 400 nT. 

2. Struktur bawah permukaan di kawasan jalur Sesar Mayor Grindulu pada Formasi 

Qa didominasi oleh endapan pasir, batu pasir, lumpur, lempung, kerakal, kerikil 

dengan rentang nilai suseptibilitas (0-2)×10-3. Formasi Tmj terdapat intrusi basalt 

dengan rentang nilai suseptibilitas (12,5-165)×10-3 dan batu pasir dengan rentang 

nilai suseptibilitas (0-2)×10-3. Formasi Toma terdapat batu gamping dan batu 

lempung dengan rentang nilai suseptibilitas (2,2-2,8)×10-3, batu tuf dengan rentang 

nilai suseptibilitas (5,1-6,4)×10-3 dan batu breksi dengan rentang nilai suseptibilitas 

(33-68)×10-3.  
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3. Dugaan jalur Sesar Mayor Grindulu memiliki karakteristik sesar geser yang berada 

pada formasi batuan yang sama (Formasi Toma) sehingga tidak terlihat kontras nilai 

suseptibilitas batuan di kawasan jalur sesar tersebut. 

 

B. Saran 

Berdasarkan hasil penelitian yang diperoleh disarankan untuk: 

1. Perlu dilakukan penelitian dengan jarak antar titik pengambilan data yang lebih rapat 

untuk mengetahui secara detail batas-batas antara formasi batuan.  

2. Perlu dilakukan penelitian dengan metode lain untuk menginterpretasi struktur 

bawah permukaan dan mengidentifikasi jalur Sesar Mayor Grindulu. 
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Lampiran 1. Data Mentah Hasil Pengukuran 

Daerah     : Kecamatan Pacitan dan Arjosari Kabupaten Pacitan 

Tanggal   : 24-26 Agustus 2017 

 

No. 
Nama 

Titik 

Elevasi 

(m) 
Waktu 

Koordinat Pengukuran 

(nT) X Y 

1 BASE 1 70 

8:02 

510888 9096036 

45,003 

8:02 45,011 

8:02 45,015 

8:03 45,015 

8:03 45,030 

2 D1 421 

8:42 

506348 9096353 

44,768 

8:43 44,816 

8:44 44,730 

8:44 44,723 

8:45 44,744 

3 D2 413 

9:02 

507145 9096035 

44,827 

9:02 44,831 

9:03 44,829 

9:03 44,829 

9:03 44,827 

4 D3 370 

9:22 

507595 9096379 

44,615 

9:24 44,595 

9:24 44,625 

9:25 45,606 

9:29 45,798 
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5 D4 246 

9:56 

508456 9096307 

45,599 

9:57 45,513 

9:57 45,515 

9:57 45,495 

10:01 45,616 

6 BASE 2 70 

10:43 

510888 9096036 

45,131 

10:43 45,131 

10:43 45,131 

10:43 45,131 

10:43 45,131 

7 D5 58 

11:40 

508494 9094338 

44,849 

11:43 44,868 

11:43 44,858 

11:44 44,885 

11:45 44,852 

8 D6 152 

12:22 

507664 9094656 

44,927 

12:23 44,947 

12:23 44,908 

12:23 44,945 

12:24 44,920 

9 D7 89 

12:37 

507310 9095247 

44,723 

12:37 44,731 

12:42 44,737 

12:42 44,725 

12:43 44,724 

10 BASE 3 70 

13:20 

510888 9096036 

44,910 

13:20 44,913 

13:20 44,914 

13:21 44,903 

13:21 44,910 

11 D8 35 

14:08 

509530 9095100 

44,788 

14:09 44,773 

14:09 44,781 

14:09 44,780 

14:09 44,703 
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12 D9 50 

14:27 

510600 9095876 

44,479 

14:27 44,624 

14:27 44,623 

14:27 44,608 

14:27 44,655 

13 D10 97 

14:45 

510781 9096403 

44,712 

14:46 44,735 

14:46 44,699 

14:47 44,719 

14:47 44,759 

14 BASE 4 70 

15:01 

510888 9096036 

44,757 

15:06 44,815 

15:07 44,743 

15:07 44,761 

15:08 44,779 

15 D11  137 

15:33 

509500 9096994 

44,996 

15:33 44,952 

15:33 44,944 

15:33 44,932 

15:34 44,966 

16 D12 79 

16:14 

510263 9096285 

44,428 

16:14 44,426 

16:14 44,449 

16:15 44,410 

16:15 44,333 

17 D13 40 

16:43 

511820 9096932 

44,858 

16:43 44,802 

16:44 44,799 

16:44 44,821 

16:44 44,811 

18 D14  46 

16:52 

511371 9097254 

44,924 

16:53 44,918 

16:53 44,868 

16:53 44,928 

16:53 44,926 
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19 BASE 5 70 

17:04 

510888 9096036 

44,842 

17:04 44,852 

17:04 44,845 

17:04 44,841 

17:05 44,838 

20 BASE 6 36 

8:17 

511345 9097314 

44,848 

8:17 44,774 

8:17 44,779 

8:17 44,783 

8:18 44,772 

21 D14 117 

8:51 

509520 9096454 

45,334 

8:51 45,363 

8:52 45,349 

8:54 45,355 

8:54 45,354 

22 D15 40 

9:31 

511064 9097553 

44,988 

9:32 45,047 

9:32 45,023 

9:32 45,067 

9:33 45,057 

23 D16 32 

9:41 

511074 9097263 

44,857 

9:45 44,864 

9:46 44,850 

9:46 44,883 

9:48 44,852 

24 BASE 7 36 

9:57 

511345 9097314 

44,896 

9:57 44,903.60 

9:58 44,893.40 

9:58 44,801 

9:58 44,825 

25 D17 56 

10:16 

511414 9097859 

44,706 

10:16 44,879 

10:17 44,882 

10:17 44,889 

10:17 44,888 
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26 D18 34 

10:41 

510742 9097627 

45,062 

10:42 45,035 

10:42 45,130 

10:43 45,126 

10:43 45,105 

27 D19 155 

10:59 

509962 9097997 

44,842 

10:59 44,744 

11:00 44,805 

11:00 44,802 

11:00 44,817 

28 BASE 8 36 

11:24 

511345 9097314 

45,109 

11:27 44,815 

11:27 44,805 

11:28 44,779 

11:34 44,787 

29 D20 26 

12:16 

513307 9098988 

44,985 

12:17 44,973 

12:19 44,981 

12:23 45,005 

12:27 44,987 

30 D21 48 

12:40 

513013 9099027 

45,011 

12:47 45,028 

12:47 44,983 

12:48 44,987 

12:49 45,010 

31 D22 19 

13:42 

514024 9099331 

44,669 

13:43 44,656 

13:43 44,670 

13:44 44,677 

13:46 44,635 

32 D23 24 

14:05 

513815 9098219 

44,913 

14:06 44,931 

14:06 44,939 

14:06 44,918 

14:06 44,943 
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33 BASE 9 36 

14:30 

511345 9097314 

44,826 

14:37 44,770 

14:38 44,751 

14:40 44,767 

14:42 44,771 

34 D24 236 

14:58 

512766 9097644 

44,909 

14:59 44,849 

14:59 44,825 

14:59 44,830 

14:59 44,826 

35 D25 240 

15:05 

512766 9097644 

45,085 

15:06 45,077 

15:07 45,071 

15:08 45,057 

15:08 45,053 

36 D26 351 

15:18 

512031 9098668 

44,805 

15:19 44,813 

15:19 44,821 

15:19 44,809 

15:20 44,792 

37 D27 367 

15:34 

511501 9099382 

44,845 

15:35 44,850 

15:37 44,994 

15:37 45,019 

15:37 45,020 

38 D28 60 

16:17 

513592 9099630 

44,915 

16:17 45,017 

16:18 44,989 

16:19 45,014 

16:19 45,046 

39 D29 73 

16:39 

514731 9100449 

45,160 

16:40 45,153 

16:41 45,141 

16:41 45,207 

16:42 45,162 
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40 D30 192 

17:37 

513732 9101513 

45,111 

17:38 45,234 

17:38 45,209 

17:38 45,180 

17:38 45,083 

41 D31 39 

18:03 

515245 9100101 

45,000 

18:03 45,000 

18:03 44,983 

18:03 45,001 

18:03 45,014 

42 D32 30  

18:14 

514627 9098838 

45,341 

18:14 45,271 

18:14 45,291 

18:14 45,277 

18:15 45,294 

43 BASE 10 36 

18:49 

511345 9097314 

44,855 

18:49 44,816 

18:49 44,835 

18:49 44,853 

18:49 44,844 

44 BASE 11 52 

10:38 

509531 9095561 

44,815 

10:38 44,860 

10:38 44,825 

10:38 44,815 

10:43 44,860 

45 D33 60 

10:48 

509514 9095586 

45,041 

10:52 45,022 

10:53 44,966 

46 D34 76 

11:25 

509382 9095561 

44,701 

11:26 44,721 

11:27 44,734 

11:28 44,706 

11:29 44,705 
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47 D35 62 

11:43 

509521 9095556 

44,796 

11:48 44,816 

11:48 44,826 

48 D36 64 

11:52 

509510 9095551 

44,618 

11:58 44,591 

12:00 44,566 

49 BASE 12 52 

12:10 

509531 9095561 

44,922 

12:14 44,881 

12:15 44,875 
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Lampiran 2. Perhitungan Anomali Medan Magnet 

Daerah     : Kecamatan Pacitan dan Arjosari Kabupaten Pacitan 

Tanggal 24-26 Agustus 2017  

Nama 

Titik 

Koordinat 
Elevasi  

(m) 

tn 

(s)  

B 

(nT) 

BIGRF 

 (nT) 

BVH 

(nT)  

       

∆B 

(nT) 

  
X Y 

BASE1 510888 9096036 70 8:02 45015 45091 - - 

D1 506348 9096353 421 8:43 44756 45084 29 

 

-358 

 

D2 507145 9096035 413 9:02 44829 45085 43 

 

-300 

 

 D3  507595 9096379 370   9:24 45048 45085  59  

  

  -96 

 

D4 508456 9096307 246 9:57 45548 45088 83 

 

376 

 

BASE 

2 
510888 9096036 70  

 

10:43

  

 

45131

  

45091   - -  

 D5 508494 9094338  58 11:43 44862 45101  -84  

 

-154  

 

 D6 507664 9094656  152 12:23 44929  45098 -140  

 

-28 

  

D7 507310 9095247  89 12:40 44728  45097  -164 

  

 -204 

 

BASE 

3 
510888 9096036 70 13:20 44910  45091  -  - 

 

D8 

 

509530 9095100 35 14:08 44765 45097 -63 -268 
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Nama 

Titik 

Koordinat 
Elevasi  

(m) 

tn 

(s)  

B 

(nT) 

BIGRF 

 (nT) 

BVH 

(nT)  

       

∆B 

(nT) 

  
X Y 

D9 510600 9095876 50 14:27 44598 45093 -87 

 

-407 

 

D10 510781 9096403 97 14:46 44725 45089 -113 

 

-251 

 

 D11  509500 9096994  137 
15:33

  
44958 45090  16 

  

  -148 

 

D12 510263 9096285 79 16:14 44409 45091 42 

 

-723 

 

 D13 511820 9096932 40 

 

16:43 

 

 

44818 

  

45087  59  

 

-329 

 

 BASE 

5 
510888 9096036 70 17:04 44844 45091  - 

 

- 

 

 BASE 

6 
511345 9097314 36  8:17 44791 45086  - 

 

- 

  

 D14 509520 9096454 117 8:52 45351 45089  25 

  

 236 

 

  

D15 

 

511064 9097553 40 9:32 45036 45085 54  
-103 

 

 

 D16 

 

511074 9097263 32 9:45 44861 45087 63 

  

 -288 

 

 

BASE     

7 

511345 9097314 36 9:57 44863 45086 - 

 

- 
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Nama 

Titik 

Koordinat 
Elevasi  

(m) 

tn 

(s)  

B 

(nT) 

BIGRF 

 (nT) 

BVH 

(nT)  

       

∆B 

(nT) 

  
X Y 

D17 511414 9097859 56 10:16 44848 45083 -1 

 

-233 

 

D18 510742 9097627 34 10:42 45091 45083 -2 

 

8,9 

 

 D19 509962 9097997  155 10:59 44802  45081 -3 

  

-276 

 

BASE 

8 
511345 9097314 36 11:28 44859 45086 - 

 

- 

 

 D20 513307 9098988 26 

 

12:20 

 

 

44986 

 

45077  -22  

 

-69 

 

 D21 513013 9099027 48 12:46 45004 45077  -33 

 

-39 

 

 D22 514024 9099331 19 13:43 44661 45076  0.7 

 

-415 

  

 D23 513815 9098219 24 14:05 44929 45081  -68 

 

 -83 

 

   

BASE 

9 

511345 9097314 36 14:37 44777 45086 -  - 

 

D24 

 

512766 9097644 236 14:58 44848 45079 5,4 -236 

 

D25 

 

512766 9097644 240 15:08 45069 45079 7,4 -18 

   

  D26 

 

512031 

 

9098668 

  

351 

 

15:19 

 

44808 

  

45072 

     

   11   

  

-275 
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Nama 

Titik 

Koordinat 
Elevasi  

(m) 

tn 

(s)  

B 

(nT) 

BIGRF 

 (nT) 

BVH 

(nT)  

       

∆B 

(nT) 

  
X Y 

D27 511501 9099382 367 15:36 44946 45069 15 

 

-138 

 

D28 513592 9099630 60 16:18 44996 45074 25 

 

-103 

 

 D29  514731 9100449  73 16:40 45164 45069  31 

 

   65 

 

D30 513732 9101513 192 17:37 45163 45062 46 

 

56 

 

 D31 515245 9100101 39 
18:03 

 

44999 

 
 45071  52 

 

-123 

 

 D32 514627 9098838 30 18:14 45294 45077  55 

 

163 

 

BASE 

10 
511345 9097314 36 18:49 44841 45086 -     - 

BASE 

11 
509531 9095561 52 10:39 44835 45095  -     - 

D33 509514 9095586 60 10:51 45009 45094 7,4 

   

  -92 

 

BASE 

12 
509531 9095561 52 12:13 44893 45095 -     - 

 

Contoh perhitungan anomali medan magnet berdasarkan persamaan 8 : 

∆𝐵 = 45091 −  45083 + (−2)  atau           ∆𝐵 = 45091 −  45083 − (+2)        

∆𝐵 = 6 nT           ∆𝐵 = 6 nT 
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Lampiran 3. Pembuatan Desain Survei 

1. Buka Software Global Mapper seperti pada Gambar L1 → klik Open Your Own 

Data File → pilih file peta yang akan diregister → Open → Yes. 

 

 

 

 

 

 

Gambar L1. Tampilan Awal Software Global Mapper 

 

2. Setelah muncul kotak dialog Image Rectifier seperti pada Gambar L2, kemudian 

pilih Select Option dan pilih proyeksi koordinat yang diinginkan pada Projection 

→ UTM atau Geographic. 

3. Kemudian pilih salah satu ujung peta blok hingga membentuk persegi panjang → 

klik tepat pada pojok ujung peta hingga muncul titik berwarna merah → mengisi 

titik koordinat yang tercantum seperti pada Gambar L3 → klik Add Point to List → 

OK.  
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Gambar L2. Tampilan Kotak Dialog Image Rectifier 

 

 

 

 

 

 

 

 

Gambar L3. Mengisi Titik Koordinat Peta 

4. Selanjutnya ulangi langkah 3 pada ujung peta yang lain. Hasil register peta pada 

software Global Mapper akan muncul seperti pada Gambar L4. 
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                 Gambar L4. Hasil Register Peta pada Software Global Mapper 

5. Buka software Surfer, pilih menu Map → New → Base Map → pilih peta geologi 

yang telah diregister. 

6. Untuk membuat desain survei terlebih dahulu mengetahui target penelitian 

kemudian pilih satu titik di dekat daerah penelitian dengan cara pilih menu Map → 

Digitize → klik titik yang dekat target hingga muncul kotak dialog Digitized 

Coordinates seperti pada Gambar L5. 

7. Kemudian klik koordinat yang berada pada kotak dialog Digitized Coordinates dan 

Copy. 

8. Buka Worksheet dengan pilih menu File → New →Worksheet hingga muncul 

tampilan seperti pada Gambar L6. 

9. Kemudian buka Microsoft Excel tentukan titik-titik koordinat sesuai target 

dengan menjumlahkan atau mengurangkan jarak antar titik-titik koordinat. 
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10. Selanjutnya Copy titik-titik koordinat dari Microsoft Excel ke Worksheet. 

11. Pilih New Post Map hingga muncul seperti pada Gambar L7. 

12. Pilih menu Map → klik Overlay Maps hingga muncul seperti pada Gambar L8. 

 

 

Gambar L5. Kotak Dialog Digitized Coordinates 

 

 

 

 

 

 

 

Gambar L6. Tampilan Worksheet 
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        Gambar L7. Tampilan Sebelum di-Overlay dengan Titik-Titk Pengukuran 

 

 

 

 

 

 

 

 

Gambar L8. Tampilan Setelah di-Overlay dengan Titik-Titik Pengukuran 
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Lampiran 4. Tahapan Pengolahan Data 

A. Koreksi IGRF 

1. Mengakses website NOAA → pilih Geomagnetic Data and Models → pilih 

Magnetic Fields pada pilihan Online Calculators → pilih Magnetic Fields dan akan 

muncul kotal dialog seperti Gambar L9. 

 

 

 

 

 

 

 

                                      

   Gambar L9. Tampilan website NOAA Untuk Mengetahui Nilai IGRF                

di Daerah Penelitian 

 

2. Pada kolom Latitude dan Longitude diisi dengan koordinat titik pengambilan 

data dalam bentuk koordinat geografi dan diperhatikan juga lokasi penelitian 

pada lokasi lintang utara atau lintang selatan dan bujur barat atau bujur timur. 

Pada kolom Elevation dipilih Mean Sea Level dan satuan dalam meter, Start Date 

dan End Date dipilih hari selama pengambilan data, untuk Step size tidak perlu 

diganti, dan untuk Result format dalam bentuk HTML. Hasil IGRF seperti pada 

Gambar L10. 
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Gambar L10. Informasi Nilai IGRF di Salah Satu Titik Pengukuran 

B. Menghitung Anomali Medan Magnet 

1. Membuka software Microsoft Excel → memasukkan hasil pengambilan data → 

menghitung nilai koreksi variasi harian (𝐵𝑉𝐻) dengan persamaan 7. 

2. Kemudian menghitung nilai anomali medan magnet dengan persamaan 8. 

 

C. Membuat Kontur Anomali Medan Magnet 

1. Buka software Surfer 12 pilih File → New → Worksheet. 

2. Memasukkan data pada worksheet dengan format kolom A = koordinat x, kolom B 

= koordinat y, kolom C = nilai anomali medan magnet seperti Gambar L11, 

kemudian simpan dalam ekstensi txt. 
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3. Pilih Grid → Data → pilih data anomali medan magnet yang telah disimpan. 

Setelah muncul dialog Grid Data → pilih Natural Neighbor pada Gridding Method 

kemudian klik OK. 

 

 

 

 

 

 

                        Gambar L11. Pembuatan Kontur Anomali Medan Magnet 

4. Buka New Plot → Map → New → Contour Map → pilih file dalam format *.grd. 

Kemudian atur peta kontur agar lebih mudah dalam pembacaan pada kotak 

pengaturan kontur di sebelah kiri seperti pada Gambar L12. 

 

 

 

 

 

Gambar L12. Hasil Kontur Anomali Medan Magnet 
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D.   Reduksi Ke Kutub 

1.  Membuka terlebih dahulu file anomali medan magnet untuk kemudian melakukan 

proses reduksi ke kutub pada software Oasis Montaj. 

2.  Buka software Oasis Montaj → pilih File → Project → New → simpan  project 

dengan nama yang diinginkan. 

     

3. Pilih menu Data → New Database dan akan muncul kotak dialog seperti pada 

Gambar L13 dan simpan nama file kemudian klik OK. 

 

 

                                                                                                                               

 

 

 

 

 

        Gambar L13. Membuat Kontur Anomali Medan Magnet di Software                        

Oasis Montaj 

4. Pilih menu Data → Import → Ascii untuk mengimpor data sehingga akan muncul 

kotak dialog Import Wizard. Kemudian pilih data anomali medan magnet dalam 

ekstensi .txt dan pilih Next untuk Data Import Wizard Step 1-2. 
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5. Pada Data Import Wizard Step 3 of 3 klik kolom pertama kemudian isi pada bagian 

Parameters. Channel name diisi easting dan Label diisi x seperti pada Gambar L14. 

Kemudian klik kolom kedua Channel name diisi northing dan Label diisi y. 

Selanjutnya klik kolom ketiga Channel name diisi anomali dan Label diisi z 

kemudian klik Finish dan simpan template. 

 

 

 

 

 

 

       

Gambar L14. Tampilan Nama Channel dan Label 

6. Setelah itu akan muncul kotak dialog Create New Database, pada bagian New 

Database Name isi dengan nama yang diinginkan kemudian disimpan dan klik OK. 

Hasil import data ditunjukkan seperti pada Gambar L15.  

7. Untuk mengatur koordinat yang digunakan pilih menu Coordinates → Change X,Y 

Coordinates maka akan muncul kotak dialog Set current X,Y channels seperti pada 

Gambar L16. 

 



100 
 
 

 

 

 

 

 

 

 

Gambar L15. Tampilan Hasil Import Data 

 

 

 

 

Gambar L16. Pengaturan Koordinat 

8. Pilih menu Grid → Gridding → Minimum Curvatur → Dialog Controls, maka akan 

muncul kotak Minimum curvature Gridding. Pada bagian Channel to Grid pilih 

anomali kemudian beri nama file grid dan pilih OK. 

9. Untuk memunculkan menu MAGMAP pada Oasis Montaj maka pilih menu GX → 

Load menu kemudian muncul kotak dialog Load menu pilih magmap.omn dan 

Open sehingga muncul menu MAGMAP. 
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10. Untuk tahapan Reduce To Pole (RTP) maka pilih menu MAGMAP → Step by Step 

Filtering →Prepare Grid sehingga muncul kotak dialog FFT2 grid pre-processing 

kemudian simpan. 

11. Setelah itu pilih menu MAGMAP → Step by Step Filtering → Apply Filter. Pada 

kotak dialog Name of input Transform File pilih file hasil output yang telah 

disimpan sebelumnya dan beri nama kemudian klik OK, sehingga muncul hasil 

RTP seperti pada Gambar L17. 

 

 

 

 

 

 

 

Gambar L17. Hasil RTP 

 

E. Kontinuasi Ke Atas 

1. Pilih menu MAGMAP → Interactive Filtering → Prepare Grid maka akan muncul 

kotak dialog FFT2 grid pre-processing. Pilih hasil RTP pada kolom Name of Input 

(Original) Grid File dan beri nama pada kolom Name of Input (Original) Grid File 

sesuai yang diinginkan kemudian pilih Start. 
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2. Pilih menu MAGMAP lagi → Interactive Filtering → Forward FFT maka akan 

muncul dialog FFT2IN pada kolom Name of Input pre-processed Grid File pilih 

hasil pengolahan pada langkah 1 kemudian klik OK. 

3. Kemudian pilih menu MAGMAP lagi → Interactive Filtering → Radial Average 

Spectrum maka akan muncul dialog FFT2RSPC. Pada kolom Name of Input 

Transform (grid) File pilih file hasil pengolahan langkah 1. Pada kolom Name of 

Output Spectrum File beri nama sesuai yang diinginkan kemudian klik OK. 

4. Pilih menu MAGMAP → Interactive Filtering → Interactive Spectrum Filters 

maka akan muncul kotak dialog Interactive Spectral Filter. Pada bagian Filters 

kolom Filter Name pilih Upward Continuation Filter maka akan muncul kolom 

Continuation distance kemudian isi ketinggian yang diinginkan. Untuk melihat 

perubahan anomali medan magnet setelah dilakukan proses kontinuasi ke atas klik 

Preview sehingga muncul seperti Gambar L18 dan klik OK. 

 

 

 

 

 

 

 

Gambar L18. Preview Hasil Kontinuasi ke Atas 
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5. Pilih menu MAGMAP → Interactive Filtering → Apply Filter maka akan muncul 

dialog FFT2FLT. Pada kolom Name of Input Transform File pilih file hasil langkah 

1 kemudian pada kolom Name of Output Grid File isikan nama sesuai yang 

diinginkan. Pada kolom Name of Reference (Original) Grid File pilih file hasil 

proses RTP kemudian klik OK maka akan muncul hasil proses kontinuasi ke atas 

seperti pada Gambar L19. 

 

 

 

 

 

 

Gambar L19. Hasil Kontinuasi ke Atas 

F. Pemodelan 2D 

1.  Sebelum membuat model, tentukan kontur anomali medan magnet hasil 

kontinuasi ke atas, kemudian dilakukan sayatan pada daerah yang diinginkan. 

Pertama dengan memunculkan fitur pemodelan 2D yaitu : pilih menu GX → 

Load Menu  pilih gmsys.omn → Open. Maka menu untuk pemodelan 2D akan 

muncul. 
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2. Pilih menu GM-SYS → New Model → From Map Profile kemudian beri nama 

sesuai yang diinginkan pada model name seperti pada Gambar L20 dan klik 

Finish. 

3. Kemudian sayat sesuai dengan keinginan. Pada penelitian ini digunakan sayatan 

memotong sesar dan sejajar sesar. Cara penyayatan dengan klik kursor pada 

ujung sayatan kemudian menarik kursor dan klik kiri satu kali selanjutnya klik 

kanan pilih Done seperti Gambar L21. 

 

 

 

 

 

 

 

Gambar L20. Tampilan Awal Pemodelan 2D pada Software Oasis Montaj 

 

 

 

 

 

 

 

Gambar L21. Penyayatan Kontur Kontinuasi ke Atas 
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4. Software Oasis Montaj kemudian akan secara otomatis membuka menu di 

jendela baru yaitu GM-SYS. Sebelum memulai pemodelan, perlu diisikan data 

rata-rata IGRF, inklinasi, dan deklinasi seperti pada Gambar L22. 

 

 

 

 

 

 

 

 

 

Gambar L22. Memasukkan nilai IGRF, Inklinasi dan Deklinasi                                    

Daerah Penelitian 

 

5. Selanjutnya akan muncul tampilan pemodelan pada GM-SYS seperti pada 

Gambar L23. Pada GM-SYS bagian atas menunjukkan nilai anomali medan 

magnet, sedangkan bagian bawah menunjukkan pemodelan struktur batuan. 

Pembuatan model sebisa mungkin membuat garis merah dapat berhimpit dengan 

garis biru, dan garis hitam bisa mengikuti titik-titik hitam, sehingga nilai error 

menjadi kecil. 

6.  Kotak Action adalah tools dalam pembuatan model. Untuk membuat blok batuan, 

maka pilih Add points pada kotak Action kemudian tambahkan titik dengan menarik 
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garis di antara dua titik pada garis merah dan hubungkan dengan split block. Pilih 

Accept new block maka akan muncul seperti pada Gambar L24. 

 

 

 

 

 

 

 

 

Gambar L23. Tampilan Awal GM-SYS 

           

           

           

           

           

           

          

 Gambar L24. Pembuatan Blok Batuan pada GM-SYS 

9. Untuk memodifikasi atau membuat model dapat dilakukan dengan menambah 

titik, membuat blok baru, menghapus blok dan menyatukan blok-blok. Untuk 
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mengubah suseptibilitas model batuan dilakukan dengan memilih examine pada 

kotak action  → klik blok yang ingin diubah  → klik panel A/C pada bagian 

suseptibilitas kemudian muncul kotak dialog baru sebagai pengubah 

suseptibilitas  dan ubah sampai nilai error mengecil seperti pada Gambar L25. 

Untuk mengubah satuan suseptibilitas dapat dilakukan dengan pilih Display → 

Anomaly Units → pilih sesuai keinginan. 

 

 

 

 

 

 

 

Gambar L25. Tampilan Pemodelan 2D pada Oasis Montaj 

 

 

G. Pemodelan 3D 

 

1. Buka Software Oasis Montaj → buka File kontur anomali medan magnet yang 

sudah di RTP. 

 

2. Pilih data → New Database –→ beri nama sesuai yang diinginkan → OK. 

 

3. Pilih Grid → Utilities → Grid Profile. Pada bagian Grid 1 dipilih peta yang mau 

disayat untuk pemodelan kedalaman → bagian New Line Name diberi nama 
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untuk model kedalaman → Sample Interval diisi sesuai dengan kebutuhan → 

OK → OK. 

4. Kemudian sayat dari ujung kiri ke ujung kanan. Penyayatan sekiranya dapat 

mencakup nilai terendah dan tertinggi klik kiri → tarik kursor sampai ujung 

sayatan → klik kiri satu kali → klik kanan → Done. 

5. Pilih menu Utility → Make Distance Channel → OK. Maka akan muncul satu 

kolom lagi di bagian paling kanan. 

 

6. Pilih menu Data → Export → Other → pilih format *.csv → beri nama sesuai 

keinginan.                                       

7. Buka software Surfer, pilih file  →  Open File  →  buka data File dalam format 

csv yang tadi telah disimpan dari software Oasis Montaj. Ubah kolom dari : x| y 

| G atenuasi | distance  → menjadi distance | G atenuasi dengan judul tiap kolom 

dihapus. 

8. Pada bagian Input masukkan File RTP yang belum diatenuasi, beri nama Output 

sesuai keinginan → OK. 

 

9. Buka Surfer 12 → Map Contour → nama simpanan dari software Surfer 12 

sebelumnya → kemudian pada kolom kiri pilih General → Save → pilih format  

*.DAT. Buka worksheet → buka nama file simpanan dalam format *.DAT 

sebelumnya → salin kolom 1, 2, dan 3. 
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10. Buka software Surfer lagi → General → Grid Info → Grid Geometry → copy 

bagian x minimum sampai y spacing → kemudian paste di Excel lalu ubah dari 

km menjadi m dengan dibagi 1000. 

11. Buka software Magblox seperti Gambar L26 →  pilih cancel. Pada bagian kiri 

bawah pilih ignore. Kemudian masukkan data sesuai keterangan berikut 

berdasarkan data yang telah diperoleh dari software surfer yang sudah disalin 

ke Microsoft Excel: 

X posit : X min        Norm Field : Rata-rata IGRF    

Y posit : Y min    di daerah penelitian 

Z posit : 0 Inclin : Nilai inklinasi 

X size : X maximum Declin : Nilai deklinasi 

Y size : X minimum X step : x spacing 

Z size : 0 Y step : y spacing 

X divis : 6 (sesuai keinginan) X start : x min 

Y divis : 6 (sesuai keinginan) Y start : y min 

Z divis : 6 (sesuai keinginan) X ending : x max 

Sucept :  nilai   suseptibilitas Y ending : y max 

    rata-rata   

Untuk setiap langkah pengisian data harus selalu diakhiri dengan klik Update. 

 

 

 

 

 

                    Gambar L26. Pengisian Data Awal di Software Maxblox 
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12.  Kemudian pilih exit → save dua kali dengan nama yang sama → selanjutnya buka 

Software Surfer → buat kolom berikut → beri nama sesuai keinginan (misal : model 

3D) sesuai judul di kolom paling atas. Kolom x km diisikan koordinat x dalam km, 

kolom y km diisikan koordinat y dalam km, dan HA adalah nilai hasil RTP. Save 

dengan format *.DAT 

 

13. Buka Software Magblox → Open → buka format simpanan pertama dengan 

format *.inp → File → Read Data → model 3D.dat  maka akan muncul seperti 

pada Gambar L27. 

 

 

 

 

 

 

 

 

 

 

Gambar L27. Tampilan Maxblox setelah Read Data Anomali Medan Magnet 

 

14. Pada bagian iterasi  seperti pada Gambar L28 diganti 5  kali atau sesuai dengan 

kebutuhan → Compute → Optimize → Loading → tunggu sampai selesai 

kemudian  cek Layer per Layer seperti pada Gambar L29. 
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Gambar L28. Proses Iterasi 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar L29. Tampilan Layer 1 

 

15. Klik Exit → OK → Save dua kali dengan nama yang sama namun format berbeda. 
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16.  Apabila diperlukan, Blox-Blox bisa diubah dengan menggunakan Software 

Bloxer. 

17. Buka software Bloxer → Edit → Edit Single Blox → ganti nilai Value sesuai 

keinginan dengan terlebih dahulu meng-klik kanan Blox yang ingin diganti nilai 

suseptibilitasnya. Edit Params → klik kiri pada Blox → klik kanan. 

 

18. Setelah selesai mengedit seperti pada Gambar L30, Save Model as *.INP 

 

 

 

 

 

 

 

 

 

 

 

Gambar L30. Edit Model menggunakan Software Bloxer 

 

19. Buka Microsoft Excel → New Sheet → Drag file hasil Software Bloxer dalam 

format *.blx ke Excel Sheet – klik pada kolom A → data → Text To Columns → 

Delimited → OK. Lalu konversi satuan x dan y dari km menjadi m dengan 

dikalikan 1000 → Save as. 
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20. Buka Sheet baru kemudian buat data dengan format | koordinat x (m) | koordinat 

y (m) | kedalaman (m) | suseptibilitas | kemudian salin data. 

21. Buka software Rockwork kemudian Paste data dari langkah 20 ke sheet pada 

software Rockwork seperti pada Gambar L31. 

 

 

 

 

 

 

 

 

 

 

Gambar L31. Pengisian Data Awal pada Software Rockwork 

 

22. Pilih menu Solid → Model kemudian munculkan tanda (+) di semua poin 

selanjutnya pilih Create New Model → Solid Model Name beri nama model 3D 

sesuai keinginan  → Process  → Yes  → OK maka akan muncul tampilan seperti 

pada Gambar L32. 

23. Kemudian Software Rockwork akan mengolah data menjadi model 3D. Untuk 

mempermudah dalam menginterpretasi, model dapat diputar dan disaring 

berdasarkan nilai suseptibilitasnya. Cara memunculkan Tools untuk melihat 

model secara detail dengan klik kanan Solid Model → Option. 



114 
 
 

 

 

 

 

 

 

 

 

Gambar L32. Hasil Pemodelan 3D 
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Lampiran 5. Dokumentasi 
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